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About Flare 

Flare is a comprehensive drug design platform including both structure-based and ligand-based methods. 

Capabilities in Flare V9 include: 

• Smart import and handling of protein-ligand complexes 

• Accurate and reliable protein preparation 

• Ligand preparation, including enumeration of stereo centers, stripping of salts, protonation at pH 7 and 

tautomer enumeration 

• Sequence alignment and superimposition 

• Accurate docking using Lead Finder™ 

• Advanced ligand-based conformation hunt and alignment 

https://www.cresset-group.com/software/flare/
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• Pharmacophore building with FieldTemplater™ 

• Electrostatic Complementarity™ maps and score 

• Protein interaction potentials 

• Qualitative Structure-Activity Relationship analysis using Activity Atlas™ and Activity Miner™  

• Quantitative SAR models of regression and classification using Field QSAR and machine learning 

methods 

• Enumeration to generate libraries and arrays based on more than 100 popular synthetic chemistry 

reactions 

• Chemical exploration of a hit or lead compound using Hit Expander 

• R-Group Decomposition and Analysis 

• Scaffold hopping and bioisostere replacement using Spark 

• Molecular Mechanics/Generalized Born Surface Area (MM/GBSA) calculations of ligand-protein binding 

free energy on individual protein conformations or on conformations ensembles from Molecular 

Dynamics 

• Quantum Mechanics calculations on ligands 

• Free Energy Perturbation simulations 

• Support for the Open Force Field 

• Molecular Dynamics 

• Automatic creation of custom torsional parameters for ligands in support of Dynamics and FEP 

calculations 

• 3D-RISM water analysis  

• MD-based analysis of water thermodynamics with GIST 

• Pocket detection to identify potential drug binding sites in the protein targets of interest 

• Homology modeling to create reliable 3D structures for the targets of interest 

• WaterSwap analysis for ligand and binding site energetics 

• Minimization of protein ligand complexes using XED and OpenMM 

• The Flare Python™ API 

 

Docking and scoring can be performed in Flare using the Lead Finder docking algorithm.1 Lead Finder 

combines a genetic algorithm search with local optimization procedures, making this docking engine 

efficient in coarse sampling of ligand poses and following refinement of promising solutions. Three different 

scoring functions are employed and optimized for the accurate prediction of 3D docked ligand poses, 

protein-ligand binding energy and rank-ordering of active and inactive compounds in virtual screening 

experiments.  

Ensemble docking is a module of Flare for considering active site flexibility when alternative active site 

conformations of the same protein are available. Docking is performed within a workflow which enables the 

inclusion of multiple proteins in the same docking run, each corresponding to a different conformation of 

the active site.    

In both traditional and ensemble docking experiments, template docking is useful when you know the pose 

of a ‘template’ ligand and wish to use this information to bias the docking results for congeneric 

compounds. The molecules to be docked are aligned by substructure to the template ligand, and the 

aligned conformation is used to seed the docking run, generally leading to improved docking results.  

Covalent docking is a module of Flare for predicting the binding pose and interactions of covalent inhibitors, 

a class of ligands which derive their activity by forming a covalent bond with the target while making at the 

https://www.cresset-group.com/software/spark/
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same time a network of non-covalent interactions with the active site. Ensemble covalent docking extends 

the applicability of ensemble docking to covalent inhibitors. 

Ligand-based alignments can be used in Flare to make meaningful comparisons across chemical series, and 

to generate sensible poses within a protein active site. Ligands can be aligned by using the ligand fields, by 

using shape properties or by using a common substructure. Using the fields gives a ‘protein's view’ of how 

the molecules would line up in the active site, generating ideas on how molecules with different structures 

could interact with the same protein. Using substructure or common shape properties shows how the fields 

around a single chemical series vary with activity. The Conformation Explorer can be used to inspect and 

analyze conformation populations generated by Flare. 

In the absence of structural information about the protein target of interest, FieldTemplater can be used to 

build informative hypotheses of bioactive conformation, more informative and detailed than traditional 

pharmacophores. 

Flare calculates and displays protein interaction potentials (protein fields) based on Cresset’s XED force 

field.2,3 This methodology is extremely useful to understand the electrostatic environment of the active site 

of a protein, comparing protein and ligand electrostatics to improve new molecule design. Protein 

interaction potentials can also be used to analyze the active site of closely related proteins, to understand 

how subtle changes in the 3D conformation of the proteins, or in the protein sequence, can influence the 

electrostatic patterns of the active site. The analysis of the electrostatic patterns of a protein family using 

protein fields is also useful to inform the design of more selective ligands. 

The Electrostatic Complementarity4 coloring and scoring functions within Flare are an extension of the 

protein interaction potential functions. They provide a detailed map and a quantitative score of how well 

the electrostatics of one or more ligand(s) matches that of the protein active site and can accordingly prove 

invaluable for the understanding of ligand binding, SAR and the design of new molecules that target the 

protein. 

Activity Miner is designed to enable the rapid navigation of complex SAR, highlighting key activity changes 

by analyzing activity and selectivity cliffs. Multiple views of the data are generated to help you find key 

molecule pairs in your SAR. For each pair, Activity Miner shows you how the electrostatic and shape 

properties differ, building an understanding of how to design better compounds with better properties. The 

different views enable you to focus on different aspects of your SAR. 

Activity Atlas is a probabilistic method of qualitatively analyzing the Structure-Activity Relationships (SAR) of 

a set of aligned compounds as a function of their electrostatic and shape properties. The method uses a 

Bayesian approach to take a global view of the data in a qualitative manner. Results are displayed using 

Flare visualization capabilities to gain a better understanding of the electrostatics, hydrophobics and shape 

features which underlie the SAR of your set of compounds.  

Predictive quantitative SAR models can be built in Flare using either Field QSAR (Flare's implementation of 

3D-QSAR) or machine learning methods for regression and classification. The models can be built using 

either Cresset 3D descriptors, modelling the electrostatics and shape of aligned ligands, or built-in/imported 

2D descriptors and fingerprints. 

Enumeration in Flare is based on the RDKit enumeration method5,6 and can be used to enumerate arrays and 

libraries of small-medium size (up to approximately 10K) from the Flare GUI, while larger libraries can be 

enumerated by saving the output to disk. 

The Hit Expander module can be used to perform a chemical exploration of a single hit or lead compound, 

by adding a choice of small substituents and performing aromatic single-atom substitutions. The 
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enumerated variants can then be triaged using Flare FEP, MM/GBSA, an existing QSAR model or 

Electrostatic Complementarity. 

R-Group Analysis is based on the RDKit decomposition method7 and can be used to quickly analyze the 

substitution pattern of a ligand series with a common core, gathering useful information about the chemical 

exploration and SAR for the series under investigation. 

Spark is Cresset's bioisostere replacement tool. Spark can be used in a scaffold hopping or R-Group 

replacement experiment to replace a specified portion of a starter molecule, using the Cresset XED force 

field2,3 to generate a list of new molecules containing replacement fragments with similar electrostatic and 

steric properties. Spark can also be used to perform fragment joining/growing, macrocyclization and X-ray 

water replacement experiments. A special version of docking can be used to grow ligands and fragments into 

unoccupied regions of the active site, picking new ligand-protein interactions. Spark comes with a large 

collection of databases of fragments generated from whole molecules (e.g. commercially available or 

literature reported compounds), from synthetic reagents, from linker degraders, or from small molecule 

crystal structures. The Spark database generator module enables you to generate your own fragment 

databases. 

Molecular Mechanics/Generalized Born Surface Area (MM/GBSA8) is a method to calculate ligand-protein 

binding free energy at a level of accuracy which is theoretically in-between low-computational cost molecular 

docking, and high-computational-cost free energy simulations.  Calculations can be run on individual protein 

conformations or on conformation ensembles from molecular dynamics.  

Quantum Mechanics (QM) calculations in Flare are based on the PSI49 and GFN2-xTB10 implementations and 

can be used to perform geometry optimization and single-point energy calculations on individual ligands, 

conformations and poses, to compute and display the molecular electrostatic potential of ligands, and to 

generate the QM torsion profile for selected ligand torsions. 

Free Energy Perturbation (FEP) calculations allow for the prediction of relative binding affinity changes 

within a congeneric ligand series. In these calculations a molecule is gradually converted into a structurally 

closely related analogue via a non-physical (‘alchemical’) pathway. By assessing the free energy difference 

(ΔΔG) between the end states of such transformations, accuracies of about 1 kcal/mol compared to 

experimental values can be achieved for large datasets. FEP in Flare is developed in collaboration with Julien 

Michel et al11 at the University of Edinburgh. 

Dynamics allows to run molecular dynamics simulations using OpenMM12. It can be used to study the 

conformational changes of proteins and the stability of ligand-protein complexes. 

Grand Canonical Nonequilibrium Candidate Monte Carlo13 (GCNCMC) is available for both Dynamics and 

FEP. This method is a combination of traditional Grand Canonical Monte Carlo (GCMC) with Nonequilibrium 

Candidate Monte Carlo (NCMC): water insertions and deletions are carried out in a gradual, nonequilibrium 

fashion, improving the efficiency of water sampling and often leading to increased sampling of bound ligand 

conformations and more accurate FEP predictions. 

For molecular dynamics and free energy calculations, Flare provides both the AMBER GAFF family of force 

fields and the new Open Force Field. The Open Force Field version 2 and 1 releases (‘Sage’ and 'Parsley') are 

shipped with Flare, and it is simple to add new releases from the OFF consortium as and when they are 

available. For the Open force field, it is possible to compute custom torsional potentials using the 

DFT//GFN2-xTB, GFN2-xTB14 or the ANI-2x method.15 

3D-RISM water analysis,16 based on the XED force field, investigates the location and stability of water 

molecules in your protein. This information can be used to identify energetically unfavorable ('unhappy') 

https://www.cresset-group.com/software/spark/
https://www.cresset-group.com/software/spark-databases/
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molecules which should be possible to displace from the active site by designing a ligand with the correct 

shape and electrostatic features. Incorporating energetically favorable ('happy') water molecules in the 

analysis of the active site using protein interaction potentials will lead to a better understanding of the 

electrostatic requirements of ligand-protein interaction, and to improved ligand design. 

GIST17,18 water analysis generates a detailed map of water thermodynamics in the vicinity of a solute such as 

a protein, which can be used to decide whether the water at a given location is favorable or not compared 

to the bulk distribution. This information can be used to assess the ‘druggability’ of a protein active site as 

well as the stability of bridging water molecules. 

Pocket Detection in Flare is based on the fpocket19 and MDpocket20 methods, and can be used to identify 

and characterize pockets and cavities within a protein structure, enabling the identification of possible drug 

binding active sites, water binding pockets, channels and small cavities, large solvent-exposed sites. 

Homology Modeling is based on the ProMod3 algorithm21,22 and can be used to create reliable homology 

models for the targets of interest starting from the 3D structure of a sequence-aligned homologous 

template protein. 

WaterSwap23,24 is a Monte Carlo technique for investigating ligand-protein interactions, which allows the 

calculation of absolute protein-ligand binding free energies from first principles, condensed-phase 

simulations. This method, developed by Chris Wood et. al. at the University of Bristol, is fully integrated into 

Flare. Flare also supports advanced processing solutions for remote calculation. 

The Flare Python API enables Flare functionality to be accessed from Python and for you to customize the 

Flare interface. Python scripts can be run from the Flare graphical user interface (GUI) or by the command 

line pyflare. 
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Supplied Binaries 

Flare functionality is delivered through a graphical user interface (GUI) with two interlinked binaries (Flare, 

FieldEngine). However, the GUI will call other binaries to perform specific tasks. 

Flare The main graphical interface for Flare 

pyflare Python scripts can be run from Flare GUI or by the pyflare command line tool. This binary 

gives you access to all Flare methods directly from the command line enabling you to 

automate and script your workflows. 

Scripts which allow Flare methods to be run from the command line are available in the 

'pyflare-scripts' directory within Flare's installation directory. You can find a description of 

each script and examples of application in the README file in the same directory.  

The scripts can also be downloaded from https://gitlab.com/cresset/flare-python-pyflare. 

FieldEngine The calculation engine for Flare. FieldEngine is started directly by the primary interface to 

perform specific calculation tasks. By default, one FieldEngine binary is started for each 

CPU core on the host machine (but this can be reconfigured in the application 

preferences). The applications communicate with the FieldEngine using a TCP/IP protocol 

that can cause network access warnings in some situations.  

The FieldEngine process can be run on a remote machine with communication managed 

through a variety of methods including Cresset Engine Broker. 

Supported Platforms 

Minimum specifications per licensing level 

 Flare Visualizer 

Flare Essentials 

Flare for Academics 

Flare Designer 

Flare LigandPro Flare StructurePro 

Flare Pro+ 

RAM 8GB 16GB (32GB for QM) 16GB (32GB for QM) 

Processor 7th generation Intel i3 or 

equivalent performance 

7th generation Intel i5 or 

equivalent performance 

7th generation Intel i5 or 

equivalent performance 

GPU Integrated GPU 

 

Integrated GPU 

(Discrete graphics card: 

NVIDIA GTX 1050 or 

equivalent performance 

for minimization 

calculations) 

Discrete graphics card: 

NVIDIA GTX 1060 or 

equivalent performance 

Disk space 10GB 10GB 10GB 

Supported Operating Systems 

Flare is supplied as 64bit binaries for Windows®, macOS® and Linux®.  

https://gitlab.com/cresset/flare-python-pyflare
https://www.cresset-group.com/software/cresset-engine-broker/


Flare release notes V9.0 

July 15, 2024 © Cresset  9 

Windows® macOS® Linux® 

Windows 11 macOS Sonoma 14  Red Hat Enterprise Linux 8 

Alternative operating systems for Flare include Windows 10, macOS 13 and Ubuntu 22.04 LTS. Note that 

Red Hat Enterprise Linux 7 will no longer be supported after June 2024, as its maintenance support phase 

will come to an end. 

In addition: 

• Running FEP calculations is only supported on Linux 

• QM calculations are only supported on Windows and Linux: additionally, local calculations of QM single-

point energy in water or organic solvent are only supported on Linux 

• Automatic creation of custom torsion parameters for small molecules is only supported on Windows 

and Linux 

• Running WaterSwap calculations is only supported on Linux. 

GPU Calculations 

Flare’s Dynamics, GIST, FEP and MM/GBSA calculations require GPUs which support OpenCL or NVIDIA 

CUDA®.  

Flare V9 supports CUDA versions 9.2, 10.0, 10.2, 11.3 and 11.8 on Windows and Linux. To use CUDA, the 

NVIDIA GPU drivers must also be installed: the minimum required version of NVIDIA GPU drivers is detailed 

at https://docs.nvidia.com/cuda/cuda-toolkit-release-notes/index.html#title-new-features. 

Cresset Engine Broker 

Flare calculations can run on remote machines with communication managed through a variety of methods 

including the Cresset Engine Broker. With Flare V9, the minimum supported version of the Cresset Engine 

Broker is V3.0.1: the recommended version is V3.2. 

Installation 

Platform-dependent installation instructions are given below and at https://www.cresset-

group.com/support/support-resources/installing-desktop-applications.  

Windows 

Starting with V6, Flare uses Windows Installers (.msi files, which replace the .exe installers used in previous 

versions), to facilitate the installation of the application in corporate environments. If you have a version of 

Flare before V6 installed, is it recommended to remove it using the standard ‘Apps & Features’ Windows 

tool before installing Flare V9 (see ‘Uninstalling Flare’ for instructions). 

Standard installation 

1. Browse to the Windows folder of the Flare distribution media (or locate the installer in your Downloads 

folder) and double click the .msi installer file. 

2. Follow the on-screen instructions. 

https://www.redhat.com/en/blog/end-maintenance-red-hat-enterprise-linux-7-almost-here
https://docs.nvidia.com/cuda/cuda-toolkit-release-notes/index.html#title-new-features
https://www.cresset-group.com/software/cresset-engine-broker/
https://www.cresset-group.com/support/support-resources/installing-desktop-applications
https://www.cresset-group.com/support/support-resources/installing-desktop-applications
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Silent installation 

Flare can be installed silently using one of the following commands. 

1. To install in the default folder: 
msiexec.exe /I Flareinstaller_64bit_<vers>.msi /q 

2. To install in a specified folder:  
msiexec.exe /I Flareinstaller_64bit_<vers>.msi /q  

INSTALLDIR="C:\Program Files\Flare" 

Note that this may require administrator access to the directory chosen for the installation. 

Linux 

1. Install the packages required for running Flare: 

RHEL 7 and CentOS 7 
yum install mesa-libGLU libXScrnSaver xcb-util-keysyms xcb-util-

renderutil xcb-util-image xcb-util-wm nss 

RHEL 8 and CentOS Stream 8 
dnf install mesa-libGLU libXScrnSaver libnsl xcb-util-keysyms xcb-

util-renderutil xcb-util-image xcb-util-wm nss 

Debian and Ubuntu 

apt-get install libglu1-mesa libxss1 libxcb-xinerama0 libjpeg-turbo8 

2. Browse to the Linux folder of the Flare distribution media (or locate the installer in your Downloads 

folder). 

3. Install the Flare re-locatable rpm package using one of the command lines below (where <vers> is the 

version number, <arch> is the architecture and <path> is install location (/opt by default): 

yum install cresset-flare-<vers>-1.<arch>.rpm 

or  

rpm -U [--prefix <path>] cresset-flare-<vers>-1.<arch>.rpm 

4. Alternatively, unpack the supplied tar.xz file to a suitable location (e.g. $HOME or /usr/local or 

/opt). Note that the location directory in which the tar.xz file will be unpacked must be empty. 

macOS 

1. Open the supplied disc image.  

2. Drag the Flare icon onto the Applications icon to install the application in the Applications folder.  

Python Extensions and Scripts 

Python extensions are available to add optional useful functionality to Flare. From Flare V9, Flare Python 

extensions can be downloaded and installed using the ‘Extension Manager’ in the ‘Python’ tab within Flare. 

For more details and installation instructions go to  https://www.cresset-group.com/support/support-

resources/python-extensions-flare/. 

https://www.cresset-group.com/support/support-resources/python-extensions-flare/
https://www.cresset-group.com/support/support-resources/python-extensions-flare/
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Scripts to run Flare calculations from the command line or to integrate Flare into other applications are 

available in the 'pyflare-scripts' directory within Flare's installation directory and at 

https://gitlab.com/cresset/flare-python-pyflare. 

Spark Database Installation 

The database files contain conformationally explored fragments of known molecules. Cresset recommends 

installing at least the databases ‘ChEMBL_common’, ‘VeryCommon’, ‘Common’ as these cover most 

fragments that are convenient to synthesize.  

Spark fragment databases can be installed as follows: 

• By copying the databases from a network location, or a USB key, to one of the default database 

locations. Note that administrator privileges will be required to copy them to a system location 

• Using the built-in Spark Database Updater 

• Using the sparkdbupdate.py binary (requires a pyflare license). 

 

Full installation details are available at https://www.cresset-group.com/support/support-

resources/installing-desktop-applications/#sparkdb. 

The ‘Spark’ group of the Flare Preferences enables the addition of multiple custom locations for databases.  

Start Flare 

Windows 

The install process places an entry in the ‘Start menu’ and a shortcut on your desktop.  

Double click the Flare shortcut to start the application.   

Alternatively, in the search box on the taskbar type ‘Flare’ (the search panel opens automatically as you 

type). In the search results, click Flare to start the application. 

Linux 

If the installation was from rpm then select the shortcut in the Applications menu. 

Alternatively, in a terminal window type: 

/path_to_installation/cresset/Flare/bin/Flare 

where path_to_installation is the directory where the Flare distribution was unpacked. If Flare was 

installed from an rpm package keeping the default location, then the installation will be in /opt. 

macOS 

Navigate to the Applications folder and double click the Flare icon. 

Licensing 

To run Flare, you will require a valid license file or activation key, which will be supplied by Cresset, usually 

via email. If you cannot locate your license, then please contact support@cresset-group.com.  

https://gitlab.com/cresset/flare-python-pyflare
https://www.cresset-group.com/support/support-resources/installing-desktop-applications/#dblocation
https://www.cresset-group.com/support/support-resources/installing-desktop-applications/#dblocation
https://www.cresset-group.com/support/support-resources/installing-desktop-applications/#sparkdb
https://www.cresset-group.com/support/support-resources/installing-desktop-applications/#sparkdb
mailto:support@cresset-group.com?subject=License%20enquiry
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To install a license, start Flare, then choose ‘License Manager’ from the ‘File’ tab: note that if Flare cannot 

find a valid license, the License Manager panel will automatically open as you start the application. 

• Activation Key: in the License Manager panel, select the ‘Activation Key’ tab, then paste or enter the 

activation key provided by Cresset. Press the ‘Activate’ button to activate your license. 

• License File: in the License Manager panel, select the ‘License Files’ tab, click on the ‘Install a License’ 

button, browse to the location where you have saved the license file provided by Cresset, select the 

license file and press ‘Open’. Alternatively, the license file can be manually placed in one of the 

directories listed in ‘License Search Directories’.  

• License Server: in the License Manager panel, select the ‘License Server’ tab, and enter the Host/IP 

address and Port information. 

Changes to the Flare Python API 

Refer to Flare’s Python API documentation for the changes to the Python API. The documentation can be 

found in Flare’s installation directory, and can also be opened by pressing the ‘Documentation’ button in the 

Python tab of the Flare GUI. 

Changes in version 9.0 

• New Spark tab grouping all functions to perform scaffold hopping and other bioisostere replacement 

experiments with Spark. Note that the calculations ran with the ‘Ligand Similarity’ score method (using 

the Cresset XED force field) use a distance-dependent dielectric in Flare, for consistency with 

calculations performed on proteins. 

o Streamlined wizards to set up the Spark experiments in the ‘Search’ group of functions: 

▪ Scaffold hopping or R-Group Replacement wizard, to perform scaffold hopping and R-

Group exploration experiments 

▪ Ligand Growing wizard, to grow a starter molecule into new space, guided by existing 

ligands mapping a different region of the same active site, or by docking into the 

protein active site 

▪ Join Two Ligands wizard, to join together with a linker two ligands sitting in the same 

active site 

▪ Macrocyclization wizard, to cyclize a molecule by joining two atoms with a linker 

▪ Water Replacement wizard, to search for a replacement group which will displace a 

crystallographic water molecule near your ligand 

▪ The Search Constraints button can be used to set field and pharmacophore on the 

starter and reference molecules (when running searches using the Ligand Similarity 

score method) or docking constraints on relevant protein residues (when using the 

Docking score method) 

o The Database group includes functions to create and manage databases of fragments to be 

used for bioisosteric replacement experiments. Note that Flare 9 creates databases with a 

different database format from stand-alone Spark. Flare can read and use Spark-format 

databases, but not the other way round 

▪ Database Updater, to download and update Cresset-created fragment databases 

▪ Database Generator, to create custom fragment databases 

▪ Manage Databases, with several options for importing/exporting, deleting and merging 

databases, and to search databases for specific fragments 

o The Results group includes functions to analyze the results from a Spark experiment 
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▪ Clustered Results function to cluster the results of the Spark experiment 

▪ Clustering Algorithm function to choose the desired method for clustering the Spark 

results (choosing from Normal, Scaffold, Substituent, and Scaffold-Substituent 

clustering) 

▪ Toggle Tile Structure button to toggle between fragment and molecule structure when 

viewing the results in the Tile window 

o Multiple Spark experiments starting from the same or different starter molecule can be saved in 

the same projects, either in the same role, or in different roles 

o Spark results can be named and tagged according to a user-defined experiment name 

o When the results from different Spark searches are saved in the same Flare role, the ‘remove 

duplicates’ function can be used to remove structural duplicates 

o Spark searches can be exported from the GUI, to run them from the command line using pyflare 

o Spark results can be filtered: 

▪ By searching the entire result molecule structure, by setting a structure filter on the 

‘Structure’ column 

▪ By searching only the fragment/cluster structures, by setting a structure filter on the 

‘Fragment SMILES’ and ‘Cluster SMILES’ columns, respectively 

• New Homology Modeling function in the Sequences tab: 

o Connect to a secure homology modelling server hosted by Cresset 

o Build reliable homology models starting from aligned target sequences and template chains 

with sequence identity as low as 30% 

o Build single chain or multi-chain models 

o Build homology models for apo- and liganded proteins 

• New MM/GBSA Dynamics method to perform MM/GBSA analysis on pre-calculated Dynamics 

trajectories: 

o Select multiple ligand-protein complexes with an associated Dynamics trajectory to score using 

the MM/GBSA method 

o Choose to score the entire Dynamics trajectory, or a selected trajectory range 

o Choose to score all frames in the selected range of the Dynamics trajectory, or define the 

desired score interval 

o Run the calculation with a choice of implicit solvents  

o Save the scored ligands in a chosen role of the Ligands table, together with relevant MM/GBSA 

results 

• New Jupyter button in the Python tab, to launch and configure a JupyterLab Notebook using a Flare 

python kernel which enables the Notebook to interact and work with Flare 

• Significantly enhanced Extension Manager in the Python tab: 

o New ‘Update/Install Extension Package’ tab to seamlessly manage the installation and update 

of Cresset-created and user-created Flare Python Extensions 

o Add one or more update sites from which extensions can be downloaded. Update sites can be 

on a secure location on the web, or a local folder 

o Install all available extension packages, or selected packages only 

o Whenever a new version of the extensions is available, choose whether to update each 

extension package manually or automatically 

o Manage extension packages, to enforce automatic download and updates 

• New and enhanced features for molecular Dynamics: 

o Run Dynamics for multiple ligands and the same protein in the same experiment 

o Run Dynamics on ligands only  
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o New and enhanced advanced options 

▪ Create a custom equilibration protocol 

• Review the steps and conditions for the standard equilibration protocol 

• Define and save a bespoke equilibration protocol, by adding/removing existing 

steps, and changing the conditions for performing each step 

▪ The reporting frequency option is now auto adjusted to provide enhanced support to 

calculations using the GCNCMC option 

▪ The solvent box buffer option now reports the solvent/protein ratio 

▪ Re-arranged advanced options for improved usability 

o Added several additional lipid membrane models for performing Dynamics on membrane 

proteins. Furthermore, it is now possible to select the explicit water model to use with each 

lipid membrane model 

o New feature to set positional constraints to protein atoms (in addition to distance constraints) 

to restrain protein movements: 

▪ Distance and positional constraints are shown in the tooltip for the constrained atom in 

the 3D view 

▪ Distance and positional constraints used during the Dynamics experiment are now 

reported in the project Log 

o New and enhanced tools for the analysis of the dynamics trajectory: 

▪ New ‘PCA’ plot for monitoring the most important motions of a protein over a 

Dynamics trajectory, showing a 2D plot of Principal Components calculated from the 

coordinates of the heavy atoms over the Dynamics trajectory 

▪ Enhanced ‘Radius of Gyration’ plot, now also showing the running average 

o New option for clustering the Dynamics trajectory on ligand atoms only 

o Enhanced performance for Dynamics playback 

• New and enhanced features for Flare FEP calculations: 

o New option to balance the speed vs. accuracy for the adaptive lambda schedule 

▪ ‘Fast’ generates less lambda windows and accordingly leads to faster calculations, but 

with a higher chance of poor overlap 

▪ ‘Accurate’ generates more lambda windows and accordingly leads to longer 

calculations, but with a much lower chance of poor overlap 

▪ ‘Normal’ uses the default algorithm as in previous versions of Flare FEP 

o New option to set different simulation lengths for the free and bound state of the 

transformation 

o Enhanced activity plot: 

▪ New ‘Show Precision’ option and associated ‘Precision’ statistics. This option can be 

used to define an activity threshold for separating molecules which are considered 

active (with G lower than the threshold) or inactive (with G higher than the 

threshold). The Precision statistics then reports the proportion of the predicted active 

molecules which are indeed experimentally active 

▪ The activity plot now gives a warning whenever graph is disconnected, as most 

calculated statistics are not valid when this happens 

▪ Choice of activity units for displaying the plot (G, M, nM) 

▪ It is now possible to change the background color of the plot 

o New advanced option to create a custom equilibration protocol: 

▪ Review the steps and conditions for the standard equilibration protocol 
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▪ Define and save a bespoke equilibration protocol, by adding/removing existing steps, 

and changing the conditions for performing each step 

o Re-arranged advanced options for improved usability 

o Shorter timesteps can now be used when restarting failed Flare FEP jobs 

o Added several additional lipid membrane models for performing Flare FEP on membrane 

proteins. Furthermore, it is now possible to select the explicit water model to use with each 

lipid membrane model 

o The 3D window now displays the membrane box when working with lipid membrane models 

o The ‘Start’ buttons now enables to recalculate only the Gs when calculations are complete 

(useful for example when molecule are removed from the perturbation network) 

o Unit cell information is now transferred back to Flare together with equilibrated complexes 

o New option to transfer the primary activity value for each ligand from Flare to the Flare FEP 

project 

o New right-click option for the ligands in the Flare FEP project to select the same ligands in the 

Ligands table/3D Window 

o New function to select all links with high hysteresis  

o New function to select all links with poor overlap 

o Visualize relative link contributions to overall error by color-coding calculated links (blue: low 

contribution, grey: average contribution, red: high contribution) 

o Enhanced addition of intermediates for ligands with multiple changes 

o Enhanced Flare FEP perturbation network layout for dense networks 

• Opening the File menu gives a list of recently opened projects, files and places. Clicking on an entry 

opens the corresponding file/project in Flare, or browses to the selected place 

• New Create Biological Assemblies button in the Protein tab to automatically construct all biological 

assemblies described in the input PDB file 

• New Merge Ligands function in the Ligand tab, to merge two or more selected ligands into a single 

molecule 

• New features and enhancements to the Ligands table: 

o New HBA column capturing the number of H-bond acceptors for each molecule in the Ligands 

table, based on the Lipinski Rule-of-Five definition 

o New HBD column capturing the number of H-bond donors for each molecule in the Ligands 

table, based on the Lipinski Rule-of-Five definition 

o For numerical and text columns, it is possible to set a custom heatmap to color the cells in the 

column according to a user-defined sets of rules 

o New functions to collapse or expand all roles 

o The cells in the Tag column are now editable, enabling to quickly set text or numerical tags 

which can be used for filtering ligands 

o The ‘Group By’ function in the Ligand tab can be enabled also from the context menu of the 

column headers 

o URLs included in the Notes or custom columns in the Ligands table are now automatically 

detected and can be clicked to open the link in the preferred browser 

• New and enhanced pyflare command-line scripts: 

o New sparkcl.py to run Spark searches, as a drop-in replacement to the Spark sparkcl binary 

o New sparkdb.py script to create Spark databases, as a drop-in replacement to the Spark sparkdb 

binary 

o New sparkdbupdate.py script to update the Cresset-created Spark databases, as a drop-in 

replacement to the Spark sparkdbupdate binary 
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o New ‘mmgbsadynamics.py’ script to run MM/GBSA calculations on a Dynamics trajectory  

o Enhanced ‘proteinprep.py’ script, to include the option to remove post-translational 

modifications 

o Enhanced ‘feprun.py’ script, to include the option to specify the desired type of membrane 

model 

o Enhanced ‘dynamics.py’ script to include the option set positional and distance constraints, and 

to specify distance and positional constraints from a file 

o Enhanced ‘minimization.py’ script to include the option to set positional and distance 

constraints, and to specify distance and positional constraints from a file 

o Added the ‘verbose’ option to several scripts 

• Enhanced protein modelling: 

o New options for the ‘Atom’ and ‘Ribbon’ color functions in the Home tab to color code the 

residue atoms/ribbons of selected proteins by sequence identity or similarity (BLOSUM62 or 

Wei/Altman/Chang) with respect to the corresponding sequence-aligned residues of a target 

protein 

o New functions in the Sequences tab: 

▪ Tag protein residues 

▪ Sequence align only picked protein chains 

o New functions available from the context menu of the Proteins and Alignment table 

▪ New function to open the PubMed reference to the protein (if available), by searching 

the ‘PMID’ field of the ‘JRNL’ PDB record 

▪ New function to open the Uniprot reference (if available), by searching the 

‘dbAccession’ field in the ‘DBREF’ PDB record 

▪ Delete picked residues now available also from Alignment table, including residues with 

no atoms 

• Enhanced protein preparation: 

o New option to remove several types of post-translational modifications from relevant residues, 

including glycosylation, phosphorylation, methylation, acetylation and oxidation 

o New advanced option giving control over changes in protonation and tautomeric state for 

protein residues and/or ligand and cofactors (allowed by default on all molecules) 

o New advanced option giving control over Asn/Gln/His flips (allowed by default) 

o New advanced option to modify only picked residues during protein preparation 

• Enhanced MM/GBSA single-point calculations, which can now run either on GPUs (recommended if 

available) or CPUs 

• Enhanced docking and scoring: 

o New covalent warhead pattern: boronic cyclic esters 

o New advanced option to perform additional conformation sampling for flexible rings 

o For docked poses generated in the presence of flickering waters, the new ‘Flickering waters’ 

column in the Ligands table reports whether the pose was created with each flickering water 

switched either ON or OFF 

o Grid settings are now reported in the project Log 

• New and enhanced features in the Flare Preferences: 

o New ‘Spark’ group of preferences, to customize Spark database locations, update and search 

preferences 

o New 3D Display preferences 

▪ Change the thickness of tube and flat protein ribbons 
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▪ Change the stick thickness, which controls the relative thickness of bonds and atoms in 

all display modes (except line and CPK) 

o The Homology Modeling preference in the Connections group sets the URL for connecting to 

the secure Cresset Homology Modeling server 

o Removed the options which enabled the download of electron density maps with 1/3 to 1/2 

resolution from the Flare Connection preferences, due to changes into the RCSB download 

services 

• New right-click function in the Protein Alternate Conformations window to delete all unselected 

conformations (either imported with the protein structure, or created with the New Conformation → 

All Sidechain Confs function in the protein tab) 

• New Add Water button in the Editing Tools, to add a water molecule in the desired position 

• Enhanced Start button, now enabling to choose which Cresset Engine Broker instance to use for remote 

calculations 

• Enhanced calculation dialogs, now keeping track of the original calculation method when customizing 

the experiment  

• Enhanced functionality in the Home tab: 

o The Focus button can now be used to toggle on/off focused view 

o When protein ribbons are shown in the 3D view, dotted lines mark missing loops (this feature 

can be turned off in the 3D Display Flare Preferences) 

o Enhanced display of protein ribbons (can be changed in the Flare 3D Display Preferences to go 

back to the previous display) 

• Enhanced support to GIST calculations with the GCNCMC option: it is now possible to set the center of 

the GCNCMC sphere either by using a ligand, or an atom pick 

• Enhanced 3D-RISM surfaces: 

o Change color of surfaces 

o 3D-RISM surfaces move with the protein they belong to upon protein superposition 

• Enhancements to QSAR building workflows: 

o The QSAR calculation widget gives a warning when columns marked as ‘activity’ are also 

selected for QSAR model building, to avoid their accidental use as descriptors 

o Streamlined workflow for building 3D QSAR models from imported, pre-aligned molecules 

o The default maximum number of optimizer iterations for SVM regression and classification 

models (advanced options) has been changed from ‘unlimited’ to 5,000 for increased 

computational efficiency 

• New and enhanced features for the Proteins table: 

o New functions to collapse or expand all roles 

o Enhanced tooltips for ligands and cofactors included into a protein in the Proteins table, now 

showing the 2D structure 

• Enhanced handling of symmetry with electron density maps 

• Enhanced SlogP calculations for zwitterions 

• Re-introduced capability to perform a torsion analysis using the Torsion Library when in Editing mode 

• Re-organized 3D Pose tab: Conf Explorer and Torsion Analysis buttons have been moved to a new 

Analysis group 

• The Python button in the Help tab, which opens the Flare Python API documentation, has been 

renamed to ‘Python API’ for clarity 

• When creating scatter plots, it is possible to choose whether to show annotations permanently on 

selected data points or all points, or to show them on mouse hover only 

• Maximize/Minimize buttons added to the R-Group Analysis Results window 



Flare release notes V9.0 

July 15, 2024 © Cresset  18 

• Updates to third party components: 

o Update OpenMM to version 8.1.1 

o Updated OpenFF to include version Sage 2.2.0 

o Update OpenMMForceFields to version 0.12 

o Update psi4 to version 1.9 

Changes in version 8.0.2 

Fixed bug (Linux only) that caused more windows to be inserted in the final lambda array when the 

Adaptive Lambda Scheduling algorithm was used. The same bug also caused MBAR to use a smaller fraction 

of the trajectory data for the calculation of the binding free energy differences, resulting in less accurate 

predictions.  

Changes in version 8.0.1 

Fixed bug (Linux only) that prevented the users from running Flare FEP calculations with charge 

perturbation in membrane systems.   

Changes in version 8.0 

• New MM/GBSA single-point scoring to calculate ligand-protein binding free energy using the Molecular 

Mechanics/Generalized Born Surface Area (MM/GBSA) method: 

o Score hundreds of molecules from the Flare GUI 

o Score thousands of molecules from the command-line  

o Run the calculation using either OpenFF or the Amber GAFF/GAFF2 force fields to parametrize 

the ligands being scored 

o Run the calculation with a choice of implicit solvents or in vacuum 

o Run the calculation after minimizing the protein-ligand complex, the protein or the ligand only, 

or to skip minimization 

o MM/GBSA single-point calculations can be exported from the GUI, to run them from the 

command line using pyflare 

• Significantly expanded domain of applicability of Flare FEP, now supporting perturbation networks 

including ligands with different net charge: 

o Re-designed FEP calculation dialog, now giving the option to set different simulation lengths for 

transformations involving ligands with or without different net charge 

o Implemented PME non-bonded method for transformations involving ligands with different net 

charge  

o New ‘Select Charge Change Links’ option in the ‘Select’ menu of the Flare FEP project to select 

all links where a charge change happens 

• New Flare FEP analysis tools: 

o New Torsion Plot, showing a histogram of the torsion angles adopted by the rotatable bonds of 

the ligands during FEP simulations, to identify significant conformational changes that occur 

between the start and end molecules   

o New Contacts table, giving a comprehensive overview of the contacts formed between the 

ligand and its neighbouring residues (protein, water molecules, co-factors, etc.) during each 

lambda window of a transformation 
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o New Convergence Plot, showing a graphical representation of the changes in free energy (ΔΔG) 

with respect to simulation time, allowing users to assess the reliability and convergence of their 

simulations 

• New ‘Custom Parameters’ function in the 3D Pose tab, to calculate and visualize accurate custom force 

field parameters for small molecules using the DFT//GFN2-xTB, GFN2-xTB or ANI-2X methods. The 

parameters can be calculated for all supported OpenFF versions 

• New Grand Canonical Nonequilibrium Candidate Monte Carlo (GCNCMC) option for GIST water analysis: 

o Take GCNCMC steps during the equilibration stage of GIST calculations to enhance water 

sampling, potentially improving accuracy of water analysis results 

o Set the radius of the GCNCMC sphere: the sphere is automatically centered on the ligand 

included in the simulation 

o Set the number and frequency of GCNCMC moves 

o New calculation presets 

▪ New ‘Quick with GCNCMC’ calculation method to run GIST experiments using the 

Amber GAFF2 force field for small molecules, enabling GCNCMC during equilibration 

and running the Dynamics simulation for 5 ns 

▪ New ‘Normal with GCNCMC’ calculation method to run GIST experiments using the 

Amber GAFF2 force field for small molecules, enabling GCNCMC during equilibration 

and running the Dynamics simulation for 20 ns 

▪ New ‘Accurate with GCNCMC’ calculation method to run GIST experiments using the 

Amber GAFF2 force field for small molecules, enabling GCNCMC during equilibration 

and running the Dynamics simulation for 50 ns 

• New and enhanced protein and homology modelling functions: 

o New function to explore alternative conformations for the side chains of selected residues 

▪ Individual rotamers can be created on the fly 

▪ All sensible rotamers can be created at once and saved as alternate conformations for 

further inspection 

o New ‘Renumber Residues’ function to renumber picked residues or whole chains, including the 

option to renumber gaps and specify insertion codes to automatically avoid duplicate 

numbering 

o New ‘Import/Export Alignment Group’ functions to import/export FAST and ClustalW sequences 

o New ‘Mutate to Sequence’ function to mutate picked residues or whole chains to match the 

sequence of another sequence-aligned protein chain 

o New ‘Frequency Logo’ in the Alignment table, visually mapping consensus and diversity of 

sequence alignment, also showing % frequencies for each aligned residue as a tooltip 

o The ‘Grow Peptide’ function in the Editing tools now gives the option to select the secondary 

structure of the peptide being grown (beta sheet vs. alpha helix) 

o The ‘Loop Modelling’ function has been moved to the Sequences tab for increased visibility 

• New Profiles function to customize the Flare ribbon tabs: 

o Default profiles are available corresponding to the different Flare licensing options 

o Customize profiles 

▪  Show only the desired tabs and function buttons 

▪ Customize the appearance of each button 

• New function in the Column & Activity Editor, now enabling the re-calculation of imported RDKit 

descriptors for all molecules in the Ligands table 

• New option to open Spark .fsp projects in Flare. Note that only projects from version 10.7 of Spark can 

be opened 
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• New ‘Group By’ function in the Ligand tab to group all ligands according to the values in a Ligands table 

column 

• The first time you start Flare, a widget will appear asking whether you wish to opt-in to send Cresset 

telemetry data (such as license usage, button presses in the user interface, system information such as 

OS version and GPU name, whether critical errors occur) to help improve Flare. This setting can be 

changed at any time in the Flare General Preferences 

• Enhanced molecular Dynamics: 

o New option to set the center of the GCNCMC sphere using an atom pick, as an alternative to 

using a ligand to define the position of the sphere 

o The option to set the radius of GCNCMC sphere has been moved to the main Dynamics 

calculation dialog for increased visibility 

o New and enhanced tools for the analysis of the dynamics trajectory: 

▪ New ‘Radius of Gyration’ (RG) plot, showing a plot of the RG value for the alpha carbons 

of the protein as a function of time, characterizing the changes in the 

compactness/folding of the protein across the dynamics trajectory  

▪ New option to export non-consecutive frames of a dynamics trajectory 

▪ Enhanced Contacts analysis, now showing also ligand-water interactions 

• Enhancements to docking and scoring: 

o New covalent warhead patterns: -lactams/-lactones, Trifluoromethyl ketones, -hydroxy 

ketones 

o New ‘Core constraints’ advanced option to specify a substructure to restrain to the input 

conformation during the docking experiment. The substructure can be specified either by 

writing a SMARTS pattern, or by drawing it in a dedicated Molecule Editor  

o New option to expand the docking grid defined with an atom pick  

o Re-arranged advanced options for improved usability 

• Enhanced library Enumeration: 

o Added more than 100 new built-in reactions covering different types of chemistry: formation of 

bicyclic and monocyclic aromatic rings, formation of non-aromatic rings, C-C and N|O|S-C bond 

formation, deprotection, oxidation and reduction 

o New ‘search reaction’ function to quickly find the desired reaction by searching reaction names 

• Enhancements to QM calculations: 

o Visualization of HOMO/LUMO orbitals   

o Dunning’s diffuse basis sets are now available for all calculations 

o The QM torsion profile function now saves the optimized structures to a SDF file. These can be 

viewed using Flare’s Conformation Explorer 

• New and enhanced pyflare command-line scripts: 

o New ‘mmgbsa.py’ script to run MM/GBSA calculations from the command line 

o Enhanced ‘ligprep.py’ script for ligand preparation, now giving the option to de-salt structures 

o Enhanced ‘docking.py’ script: the choice of default chains for the docking experiment has been 

changed to include all ‘protein’, ‘water’ and ‘other’ chains, to ensure that all chains in the input 

protein structure are used 

o Enhanced ‘align.py’ script: the choice of default chains for the alignment experiment has been 

changed to include all ‘protein’, ‘water’ and ‘other’ chains, to ensure that all chains in the input 

protein structure are used 

o Enhanced ‘gist.py’ script: added support to GCNCMC 

o Enhanced ‘dynamics.py’ script to include the option to specify the coordinates of the center of 

the GCNCMC sphere, as an alternative to using a ligand residue 
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o Enhanced ‘fepcreate.py’ and ‘feprun.py’ script: added support to perturbations with charge 

changes 

o Enhanced qm.py: 

▪ HOMO/LUMO maps can be created from the command-line 

▪ Dunning’s diffuse basis sets are now available for all calculations 

▪ Unified PSI4 and xTB keywords 

• New and enhanced Flare Preferences: 

o New option in the Flare 3D Display Preferences to set a custom thickness/width for ribbons 

shown using the Tube/Flat display styles 

o Reorganized Cresset Engine Broker group in the Flare Processing Preferences: calculations are 

now shown grouped according to job type (Single core CPU, GPU, Multicore CPU)  

o New advanced option in the Activity Miner group of the Flare Advanced Preferences to apply 

the filters set for the Ligands table also to the Activity Miner views 

• Enhanced Ligand Prep: new option to generate a minimized 3D conformation for all ligands being 

prepared 

• Enhanced Filters: 

o New ‘Is’ and ‘Is not’ logic for substructure filtering, enabling an exact match of the structure 

being searched 

o When filtering by substructure, it is now possible to type/edit/paste a valid SMILES string to 

define the substructure 

• Enhanced Plots: new option to choose one or more columns in the Ligands table to use as labels for 

annotating scatter plot points  

• Enhanced ‘Atom Pick’ widget in the Home tab: 

o New option in the Property Pick by Residue dialog to pick capping groups and other non-natural 

amino acids 

o New option in the Property Pick by Protein Structure dialog to pick capping groups 

• Enhanced R-Group Analysis: 

o It is now possible to interact with Flare while keeping the R-Group Analysis Results table open 

o RGA Boxplots now show the Core structure with numbered R-Group attachment points on the 

top-right corner, to facilitate mapping the desired R-Groups. A tooltip also shows an enlarged 

version of the Core structure for enhanced visibility 

• Enhanced display of Activity Miner results: 

o The tooltip shown when hovering over a cell in the Disparity Matrix now shows the 2D 

structures of the focus and comparator molecules 

o By default, filters applied to the Ligands table are applied also to all Activity Miner views. This 

behavior can be disabled by disabling the corresponding option in the Activity Miner group of 

the Flare Advanced Preferences 

• Enhanced import behavior of SDF files featuring a ‘Protein_cresset’ or ‘Protein’ tag. The protein title 

taken from the SDF tag is now displayed in the ‘Protein’ column of the Ligands table for the imported 

ligand: an ‘Unassociated’ label is added to make it clear that it was extracted from the SDF file, and not 

generated by Flare 

• Enhanced ‘Unit Cell’ function in the View tab, now displaying the relevant unit cell parameters 

• New capability to paste ligands from text/plain format (as either CTAB or SMILES) into Flare 

• Enhanced display of Mogul torsion analysis results: selecting one entry in the Mogul Torsion Analysis 

table highlights the corresponding bar in the Frequency histogram 

• Enhanced Flare project Log, now allowing to edit custom entries and to filter the Log to show only 

custom entries 

https://www.ccdc.cam.ac.uk/solutions/software/mogul/
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• Enhanced ‘Update Surfaces’ widget in the Surfaces window, now enabling the user to set the 

transparency of back-facing protein structures. The default transparency value can be set in the Flare 3D 

Display preferences 

• More informative error message when trying to add XED atoms to large proteins 

• Ligand tooltips in the 3D window now show role/index information 

• New and updated Flare python extensions: 

o New ‘PAINS Filter’ extension in the Ligand tab, populating a column in the Ligands table 

reporting whether each ligand passes or fails different PAINS (Pan Assay INterference) Filters 

based on the RDKit learns how to filter PAINS/BRENK/ZINC/NIH via FilterCatalog method 

o New ‘CDD Vault’ extensions in a dedicated ‘CDD Vault’ tab, enabling users to connect to CDD 

Vault (requires an API key issued by CDD Vault) and perform substructure/similarity searches, 

find desired molecules, import all molecules from a CDD Vault project, and import saved 

searches from CDD Vault 

o The ‘Python Notebook’ extension has been moved among the ‘Additional’ extensions due to 

stability issues in the Linux environment (see ‘Known Issues and Bugs’) 

o Enhanced installation workflow for Flare extensions: featured and additional extensions can 

now be downloaded and installed separately from built-in extensions 

• Updates to third party components: 

o Updated ONNXRuntime to version 1.15.1 

o Updated RLM to version 15.1.1 

o Updated OpenFF to include version Sage 2.1.0. 

Changes in version 7.2 

• Fixed issue where the ligand identified for use in the GCNCMC calculation lies significantly away from 

the center of the unit cell of the crystal structure that can result in incorrect handling of the dynamics 

and consequently FEP calculations. Standard dynamics and FEP calculations that did not use GCNCMC 

are not affected.  

Changes in version 7.1 

• Fixed bug in the import/export of QSAR machine learning models built with RDKit fingerprints and/or 

descriptors imported from the RDKit 

• Fixed bug in the calculation of predictions with QSAR machine learning models built with RDKit 

fingerprints and/or descriptors imported from the RDKit 

• Improved calculation of descriptors imported from the RDKit for newly added ligands to an existing 

Flare project 

• Fixed bug in the definition of the energy grid for docking experiments: when using a ligand to define the 

grid position, with a default size of 6Å, the actual grid size was smaller than expected  

• Fixed bug in the coloring of protein residues at the end of a WaterSwap calculation. 

Changes in version 7.0 

• New capability to run multiple jobs in parallel: 

o Launch multiple jobs locally or remotely 

o A calculation locking system prevents unintentional deletion or modification of ligands and 

proteins actively involved in running jobs until the jobs are finished 

https://github.com/rdkit/rdkit/pull/536
https://www.collaborativedrug.com/
https://www.collaborativedrug.com/
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o Jobs which cannot be started immediately for lack of calculation resources, or as they involve 

locked molecules, are queued and automatically started as soon as possible 

• New Calculation window: 

o Monitor all running, queued, finished and cancelled jobs 

o View the calculations details for each running job 

o View time of completion of finished jobs 

o Cancel running jobs when appropriate 

o Show the project Log for completed calculations 

• New Grand Canonical Nonequilibrium Candidate Monte Carlo (GCNCMC) option for Dynamics and FEP: 

o Take GCNCMC steps during the equilibration and production stages of molecular Dynamics 

simulations in explicit solvent to improve the efficiency of water sampling 

o Take GCNCMC steps during the equilibration stage of FEP calculations to enhance water 

sampling, potentially improving accuracy of FEP predictions 

o Set the radius of the GCNCMC sphere: the sphere is automatically centered on the ligand 

included in the simulation 

o Set the number and frequency of GCNCMC moves 

• New GFN2-xTB tight-binding semiempirical method for performing Quantum Mechanics (QM) 

calculations on ligands: 

o Perform geometry optimization (minimization) on ligands, ligand conformations and ligand 

poses.  

o Perform single-point energy calculations (Linux only) on ligands, ligand conformations and 

ligand poses, in water and a choice of organic solvents 

• New Torsion Analysis method in the 3D Pose tab: choosing the ‘Mogul’ option will perform a geometry 

check of the torsions of the selected ligand using the Mogul Library from CCDC, providing information 

on the preferred experimental values of torsions for all rotatable bonds. Note that this method requires 

a valid CSD license, and a local installation of the CSD Python API 

• New ‘Search’ box at the top of the Flare GUI, to quickly locate a Flare item, including ribbon tab buttons, 

menu items, and dockable windows 

• New Export Spin/Rock Movie function in the View tab (Windows and Linux only): 

o Export a spin/rock video for the molecules shown in the 3D window 

o Choose the desired number of frames per second, resolution and speed  

o Choose whether to reverse the direction of spin/rock rotation 

• New ‘Copy as SMILES’ function available from the right-click menu of the Ligands table, to copy the 

structure of one or more selected ligands in SMILES format 

• New option for protein preparation, enabling to automatically construct the biological assembly 

described in the input PDB file 

• Enhanced molecular Dynamics: 

o New GCNCMC option 

o New ‘OpenFF with GCNCMC’ calculation method to run dynamics experiments using the Open 

Force Field for ligands, enabling GCNCMC during equilibration and production 

o New ‘GAFF2 with GCNCMC’ calculation method to run dynamics experiments using the GAFF2 

Force Field for ligands, enabling GCNCMC during equilibration and production 

o New function to create AMBER-compatible topology files without starting the dynamics, by 

setting the length of the simulation to 0 

o New ‘Export Trajectory’ function, also enabling the user to export only the desired range of 

frames from the dynamics trajectory 

https://www.ccdc.cam.ac.uk/solutions/software/mogul/
https://www.ccdc.cam.ac.uk/
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o Enhanced cluster analysis of the dynamics trajectory, with a new option to perform the cluster 

analysis only on a specified range of frames 

o Enhanced visualization of Secondary Structure analysis results:  

▪ Hovering with the mouse over a residue label in the Secondary Structure table 

highlights the corresponding residue in the 3D window 

▪ A vertical line in the Secondary Structure table marks the current frame 

o Re-designed Dynamics calculation panel and advanced options for improved usability 

o Dynamics constraints now work also to protein minimization with OpenMM 

• Enhanced FEP: 

o New sub-graphs analysis to identify sub-graphs with lower internal error statistics and more 

accurately estimate the prediction error for the ligands in each sub-graph 

o New ‘OpenFF with GCNCMC’ calculation method to run FEP experiments using the Open Force 

Field for ligands, enabling GCNCMC during equilibration 

o New ‘GAFF2 with GCNCMC’ calculation method to run FEP experiments using the GAFF2 Force 

Field for ligands, enabling GCNCMC during equilibration 

o New option to add different rotamers of the same ligand to the perturbation network 

o Automatic addition of intermediates for sp2 ↔sp3 transformations 

o Enhanced and faster creation of perturbation networks 

o Enhanced processing of links with multiple instances 

o Easier identification of intermediates in the perturbation network by means of a different 

background color 

o Enhanced logging for the creation of intermediates, now reporting the structures the 

intermediate was derived from 

o Re-designed FEP calculation panel and advanced options for improved usability 

o The ‘Generate Links’ dialog now automatically defaults to ‘Benchmark’ or ‘Production’ based on 

the number of ligands with available experimental G data included in the perturbation 

network 

• Enhanced automatic creation of custom torsion parameters for small molecules in support to FEP and 

Dynamics experiments: 

o New DFT//GFN2-xTB method, which calculates DFT single-point energies at B3LYP-D3BJ/DZVP 

level on geometries obtained with the GFN2-xTB tight-binding semiempirical method. Strongly 

recommended for general use on neutral and charged molecules, including anions 

o Enhanced fragmentation algorithm in support to all custom torsion parameters calculations. 

Note that this will cause torsion parameters calculated with previous versions of Flare to be 

recalculated 

• Enhanced protein modelling capabilities: 

o New ‘Grow Peptide’ button available from the Editing tools, to build new peptides, or grow 

existing proteins and peptides from the C-terminus, by pasting or typing a string of 1-letter 

codes for the desired amino acids  

o New ‘Copy/Paste Loop’ functions to copy selected residues into the clipboard, and paste them 

in the desired position in the protein chain to fill gaps in the protein 

o New ‘Insert Sequence Before/After’ function available from the right-click menu of the 

Alignment table, to insert a sequence of empty residues (with no atoms) in the desired position 

of the protein chain, by pasting or typing a string of 1-letter codes 

o It is now possible to pick, delete and move to a new chain empty residues in the protein 

sequence (residues with no atoms), as well as split a chain in the position between two empty 

residues 
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o Enhanced protein preparation options in support to single-point mutations, now enabling the 

user to prepare only the mutated residues, or re-prepare the whole protein after performing 

the desired mutation(s) 

• Enhancements to Hit Expander: 

o Expanded choice of substituents to add, now also including CN and CF3 

o Enhanced Hit Expander dialog, now remembering the choice of additions and aromatic 

substitutions made by the user  

o New ‘Restore default’ button to restore the default choice of additions and aromatic 

substitutions 

• Enhanced visualization R-Group Analysis (RGA) results: 

o The Core structure shown on the top-left corner of RGA Heatmaps shows numbered R-Group 

attachment points, to facilitate mapping the desired R-Groups. A tooltip also shows an enlarged 

version of the Core structure for enhanced visibility 

o Sortable R-Group Analysis Results table  

o Enhanced rendering of graphics 

• Enhancements to docking and scoring: 

o New Ensemble Covalent Docking method, to run covalent docking experiments on ensembles 

of alternative active site conformations of the same protein 

o New ‘pentafluorophenyl sulfonamide’ covalent warhead pattern 

o New advanced option for covalent docking to ensure that only the warheads matching the 

specified SMARTS patterns in the ligands to be docked are reacted during the covalent docking 

experiment 

o New ‘Flexible H-bond donors in protein’ advanced option, enabling users to specify the residues 

for which hydrogen bond donors are allowed to rotate, choosing from None (-OH and -NHx 

groups are kept in the input conformations), Ser/Tyr/Lys/Thr only, or All 

o Re-designed advanced options for improved usability 

• New and enhanced pyflare command-line scripts: 

o New ‘qm.py’ script to run QM calculations from the command line, including also the new 

GFN2-xTB method 

o New ‘ligprep.py’ script for ligand preparation (giving the options to protonate/deprotonate at 

pH 7, generate a sensible 3D conformation, minimize the input structures) 

o Enhanced ‘docking.py’ script: added support to ensemble covalent docking experiments 

o Enhanced ‘dynamics.py’ script: added support to GCNCMC 

o Enhanced ‘feprun.py’ script: added support to GCNCMC 

o Single character aliases for most options in all pyflare scripts 

o Updated help text for most command-line scripts 

• Enhanced Ligand Prep: new tautomer enumeration option 

• Enhanced QSAR model building: 

o New ‘Consensus’ method for building regression and classification models: 

▪ Consensus regression calculates the Gaussian Process (GP), Support Vector Machine 

(SVM), Multi-Layer Perceptron (MLP) and Random Forest (RF) models and predict the 

activity of molecules as the average of the predictions from the individual models 

▪ Consensus classification calculates the MLP and RF models and predicts the class 

(category) of molecules as the class predicted with the highest sum of the predicted 

probability by the individual models 

o New ‘Keep all models’ advanced option for Automatic regression and classification, to save all 

models in the Flare project rather than only the best one 
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o GP models now calculate also the standard deviation for each prediction 

o New option in the ‘QSAR Model Building’ panel to build regression (GP, SVM, MLP and RF) and 

classification (SVM, MLP and RF) models on fingerprints from the RDKit: RDKit, Morgan/Circular 

and MACCS Keys 

• New features for the Proteins and Alignment tables: 

o New ‘Roles’ for organizing the Proteins and Alignments tables: 

▪ Create new roles in addition to the default ‘Proteins’ role 

▪ Assign selected proteins to a different role, either previously created, or created on the 

fly  

▪ Select all proteins in role 

▪ Expand/collapse roles 

▪ Move roles (and the included proteins) up and down in the Proteins table 

▪ Delete roles and the included proteins 

▪ Duplicate roles and the included proteins  

▪ Edit role name and description 

o New functions available from the sequence ruler bar shown on top of the Proteins and 

Alignment tables: 

▪ Hovering with the mouse over a position in the ruler bar highlights all the residues in 

that position across all proteins, in the Proteins and Alignment tables and in the 3D 

window (if the protein(s) are shown) 

▪ Clicking on a position in the ruler bar picks all the residues in that position across all 

proteins 

▪ Double clicking on a residue in the ruler bar picks all the residues in that position across 

all proteins, and focuses the 3D window on the picked residue(s) 

▪ Click and drag over a range of positions picks all the residues in the corresponding 

positions across all proteins 

• Enhanced Column & Activity Editor: 

o New ‘Import RDKit Descriptors’ button to import a choice of physico-chemical descriptors for 

ligands from the RDKit 

o New ‘Pin Columns’ button, to pin/unpin selected columns to the left of the Ligands table 

• Enhanced Filters: 

o Implemented a ‘Include AND/OR’ and ‘Exclude AND/OR’ logic for filtering of Tags 

o Improved filtering performance for large projects 

• Enhanced library Enumeration: 

o Many reactions were updated and/or renamed to make them more comprehensive and easier 

to find 

o In the SMARTS Filters group of the Library Enumeration panel, added new buttons to: 

▪ Import/export sets of  

▪ Clear all SMARTS filters 

▪ Set all SMARTS filters to either ‘Requires’ or ‘Excludes’ 

• In the Conf Hunt and Alignment advanced options, it is now possible to draw a ‘Substructure match’ by 

using a 3D molecular editor, which will be converted to SMARTS on exiting the editor 

• Enhanced Storyboard: new option to update saved scenes by right-clicking on a scene and choosing 

‘Update Scene’, which will replace the scene with the current view in the 3D window 

• Enhanced Conformation Explorer window: reorder columns 

• Interactive Radial Plot window: 
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o With one or more ligands selected, clicking on a line in the Radial Plot window scrolls the 

Ligands table to show the corresponding ligand 

o With multiple ligands selected, double-clicking on a line in the Radial Plot window changes the 

selection to include only the corresponding ligand 

• Hovering with the mouse on top of a ligand shown in the 3D windows shows the 2D structure of the 

ligand in the tooltip, together with other relevant information 

• New ‘Permanent Annotations’ checkbox for the scatter Plot function in the Ligand tab. With this 

checkbox selected, clicking on a data point in the scatter plot will permanently show the ligands title(s) 

• New Flare Python API function enabling the import of images in the Ligands table 

• Increased backward compatibility for saving Flare projects, enabling to save Flare V7 projects as both 

Flare V6.1/6 projects 

• Updates to third party components: 

o Updated Torsion Library to version 3.0 

o Updated Sire to version 2022.3.0. Note that following this update, WaterSwap restart files 

created with previous versions of Flare will no longer work in Flare V7 

o Updated Python to version 3.9.15 

o Updated OpenMM to version 8.0.0 

o Updated RDKit to version 2022.09.3 

o Updated Lead Finder to version 2212 

o Updated Build Model to version 2212 

o Updated mdanalysis to version 2.3.0 

o Updated BioSimSpace to version 2023.0.0 

o Updated freenrgworkflows to version 1.2.0 

o Updated openmmforcefields to version 0.11.1 

o Updated openff-toolkit to 0.11.4 

o Updated OpenSSL to version 1.1.1t 

o Updated Boost to version 1.80.0 

o Updated Qt to version 5.15.7 

o Updated QtitanRibbon to version 6.3.1 

Changes in version 6.1 

• New R-Group Analysis (RGA) module in the Ligand tab, based on based on the RDKit decomposition 

method: 

o Quickly analyze the substitution pattern of ligand series with a common core 

o Specify the common core for the decomposition by picking atoms in the 3D window, or by using 

SMARTS 

o Decompose all ligands in the project or only those in selected role(s) 

o Create a RGA table reporting the R-Groups found in each ligand, together with selected 

properties from the Ligands table 

o Choose the properties to show in the RGA table 

o Transfer the results of the RGA back to Flare, as additional columns in the Ligands table, 

enabling further analysis 

o Use RGA Boxplots to investigate the distribution of properties for each R-Group found in the 

ligand series at a certain attachment point 

o Use RGA Heatmaps to analyze the effect on properties of changing substituents at two different 

R-group positions 

o Use RGA Heatmaps to identify gaps in the chemical exploration for the ligand series 
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• New Hit Expander module to perform a rapid chemical exploration around a selected hit or lead 

compound, by introducing small modifications (substituents and aromatic substitutions) to the initial 

ligand. The resulting variants can be prioritized by means of quick Flare FEP calculations, by using an 

existing QSAR model, or by using Electrostatic Complementarity maps and scores 

• New Record movies function in the View tab (Windows and Linux only): 

o Choose whether to record the main Flare window, the Flare 3D Display, or the full screen 

o Choose the desired number of frames per second, resolution and speed  

• New Superpose function in the 3D Pose tab, to superpose two ligands based on their maximum 

common substructure or 3-5 picked atoms 

• New Radial Plot window, showing the radial plot(s) for selected compounds in a separate dockable 

widget 

• New Boxplot function in the Ligand tab to show boxplots of selected properties 

• New ‘Pick Visible Atoms’ option for the Pick function in the Home tab 

• Enhanced functionality for the ‘Start’ button of most calculation panels, now enabling to choose 

whether to start the calculation locally, remotely using the Cresset Engine Broker if available, and to set 

the maximum number of single/multi core CPU resources and GPU resources for running the calculation 

on the Cresset Engine Broker 

• Enhanced FEP: 

o New option to use a pre-calculated solvation box (either explicit solvent or membrane/solvent) 

for the FEP experiment 

o New advanced option to set the solvent buffer thickness in Å in the z direction for calculations 

with membrane solvent model 

o New ‘Very Quick’ calculation method suitable for the quick triage of datasets including small 

modifications, such as those generated by the Hit Expander module 

o New Link Plot for examining the FEP results and troubleshooting individual link calculations 

o Additional controls for zooming in/out the perturbation network, which can now be performed 

by ALT key + Left mouse button 

• Enhanced molecular Dynamics: 

o New and enhanced tools for the analysis of the dynamics trajectory: 

▪ New cluster analysis of the dynamics trajectory 

▪ Enhanced analysis of ligand-protein contacts, which can now be run on the whole 

trajectory or focused on a selected cluster 

o New option to export a movie of the dynamics trajectory, choosing the desired number of 

frames per second, resolution and speed 

o New option to use a pre-calculated solvation box (either explicit solvent or membrane/solvent 

solvation models) for the Dynamics experiment 

o New advanced option to set the solvent buffer thickness in Å in the z direction for simulations 

with membrane solvent model 

o Support for additional non-standard residues 

• Enhanced automatic creation of custom torsion parameters for small molecules in support to FEP and 

Dynamics experiments: 

o New GFN2-xTB (tight-binding semiempirical) method, applicable to both neutral and charged 

ligands 

o Enhanced ANI-2X (machine learning approximation to DFT) method. This new version generates 

more accurate custom torsion parameters for neutral molecules with respect to the previous 

version of the method and to GFN2-xTB, at the cost of sometimes significantly longer 

calculation times 
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• Enhanced QM calculations: 

o New Electron Density maps for minimized ligands, saved in the Surfaces window 

o Enhanced display of ESP maps: ESP values are now projected onto the solvent-accessible 

surface and colored according to the Colors preferences for positive/negative electrostatics 

o QM calculations can be launched from macOS to run on Linux through the Cresset Engine 

Broker 

o New option to run the calculation on a copy of the ligand, preserving the original ligand 

structure 

o Updated PSI4 to version 1.6 

• Enhanced Conformation Explorer to inspect the results of QM calculations: 

o QM columns can be plotted as histograms 

o Absolute QM Energy, HOMO, LUMO and Dipole moment are now reported for each 

conformation 

• Enhanced QSAR model building: 

o New Multilayer Perceptron (MLP) method for building regression and classification models  

o Improved GUI for selecting Cresset 3D and custom descriptors for building regression and 

classification models 

o Improved Flare Project Log: 

▪ New ‘Show Log’ button in the QSAR tab 

▪ The Project Log window now automatically scrolls to the log of the selected QSAR 

model 

▪ The Project Log for classification models now reporting statistics for each individual 

class in the training/trainingCV/test sets 

• Enhanced Column & Activity Editor, now enabling also to set descriptors for QSAR analysis 

• Enhancements to docking and scoring: 

o New option to enumerate stereoisomers before docking 

o New option in the Flare General Preferences to set the path to a custom ATPAT pattern file 

containing the definitions for the covalent warheads to be used for covalent docking 

• Enhanced histograms and plots: 

o Customizable background/foreground color of both histograms and plots 

o Customizable color for selected/non selected ligands in histograms 

o Customizable point markers shape, size and color for plots 

o Ligand index can now be plotted 

• Enhanced ligand preparation function, now enabling to enumerate only undefined stereocenters 

• Enhanced sequence alignment, now including the option to align only the selected proteins 

• Enhanced Preferences: 

o General preferences: 

▪ New option to enable adjustments of the background color of the 3D window when 

selecting a different Flare color theme 

▪ New option to set the path to a custom ATPAT pattern file containing the definitions for 

the covalent warheads to be used for covalent docking 

o 3D Display preferences: 

▪ New option to set the transparency of back-facing protein structures 

▪ New option to set the shininess of all 3D surfaces to achieve the desired effect 

o Colors preferences: 
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▪ New option to set the background for the 2D depiction of ligand structures in the 

Ligands table to a colored strip (new default color), to improve visibility of the chemical 

structure 

▪ New option to set the global thickness of ligand-protein contacts and measurements in 

the 3D window 

o 2D Display preferences: new option to disable the role name watermark in the Ligands table 

o Processing preferences: 

▪ Re-designed layout of the panel to facilitate setting the Cresset Engine Broker 

▪ Cresset Engine Broker panel now shows messages detailing which calculations are not 

supported by the current Flare license 

▪ New ‘Restore’ button to restore the number of CPU local processes to the default value  

o Advanced preferences: new options for setting the Screen Recorder preview interval and 

whether to always open the screen recording configuration panel before starting the recording 

• Improved Torsion Analysis function, now coloring the ligand bonds (instead of ligand atoms) according 

to the corresponding torsion frequency value 

• Improved 3D-RISM calculation panel: 

o Calculations are now allowed to run on the whole protein only, as this is validated to give the 

most accurate results 

o New option to run the 3D-RISM calculation on a copy of the protein, preserving the original 

protein structure 

• Enhanced options for creating protein surfaces including field surfaces: 

o New option to create a surface near the selected ligands, also enabling the creation of a surface 

for selected proteins with undisplayed atoms 

o New option to increase the transparency of the back-facing surfaces according to a value set in 

the Flare 3D Display preferences 

o Improved surfaces clip behavior, now enabling to set multiple clips at the same time 

• Enhanced labels for atoms in the 3D window: 

o New options to change the background color and background style for labels on picked atoms  

o New options for annotations:  

▪ Set text color and font size 

▪ Set background color and style 

▪ Draw a line connecting the annotation to the atom it belongs to 

▪ Move the annotation to the desired position in the 3D window 

• Enhanced cap chain options for protein preparation, now including an option to cap all termini 

• Enhancements to pyflare command-line scripts: 

o New ‘popto3d.py’ script to generate sensible 3D conformation for ligands from the command 

line 

o New option to disable calculation on local GPUs in favor of remote GPU resources 

o The ‘docking.py’ script now supports the input of ligands in SMILES format 

• Improved Protein Structure Checker now reporting residues with uncommon protonation state 

• Improved Library Enumeration panel, now showing the 2D depiction of an example reaction for all built-

in reactions 

• Improved visualization of DNA/RNA ribbons in the 3D window 

• Improved visualization of Electron Density surfaces, now offering the option to match the chains of the 

protein to the shown unit cell display 

• Improved behavior of ‘Save Picture’ functionality in the View tab, now enabling to specify a resolution 

multiplier for the saved pictures 
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• Improved Interaction Maps, now giving the option to save the map as a .svg file 

• Improved FieldEngine behavior, now enabling all calculations to use the same set of FieldEngines 

• Support to Gaussian cube files (read only) 

• Improved Processing error dialog, now enabling to copy the error text to the clipboard and to save it as 

a .txt file 

• Improved ‘Copy to Clipboard’ behavior for copying the content of a column in a Ligands table into the 

clipboard, now using the ‘text/plain’ format, enabling to then paste the column content into a larger 

variety of tools including Excel, Word, Notepad++ and KNIME Table Creator. 

Changes in version 6.0.1 

• Fixed bug in the OpenMM component of Flare FEP and Dynamics which in some systems caused water 

molecules to be erroneously placed in positions that clash with the protein structure 

• Fixed license bug in QSAR model building 

• Fixed bug in the import/export of QSAR models 

• Fixed incorrect file permissions in Flare Linux tar installer. 

Changes in version 6.0 

• New Enumeration module in the Ligand tab, based on the RDKit enumeration method: 

o Enumerate arrays and libraries of small-medium size (up to approximately 10K) directly from 

the Flare GUI, and larger libraries by saving the output to disk 

o Choose from a list of more than 50 pre-defined, ready to use popular synthetic chemistry 

reactions 

o Create multi-step reactions by choosing the output of the previous reaction as one of the 

reagents 

o Save enumeration results either in a pre-defined or custom-created role in the Ligands table 

(only for libraries up to 10K) or to disk 

o Read reagents from a role in the Ligands table, from file, or from the output of a previous 

reaction 

o Create custom reactions by typing Reaction SMARTS 

o Save custom-created reactions locally, import/export custom-created reactions to share across 

different Flare installations 

o Filter enumeration results by setting: 

▪ The maximum number of results to keep 

▪ Physico-chemical filters 

▪ Sub-structure filters specified either by drawing the desired substructure in a dedicated 

editor, or by entering SMARTS patterns 

• New Pockets method in the Proteins tab to identify and analyze different types of pockets and cavities 

in proteins of interest, including drug binding sites, water binding pockets, channels and small cavities, 

large solvent-exposed sites. 

o When run on an individual protein structure, maps potential binding sites as multi-color 

surfaces: 

▪ Each surface is associated to a ‘pocket residue’ appended to the protein structure, 

which can be used to map potential binding sites for docking and GIST analysis 

▪ The associated Pocket Information table further characterizes each pocket according to 

a number of different parameters, including an overall Score (giving an indication of the 

likelihood that the pocket is a binding site) and a Druggability Score 
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o When run on the results of a dynamics simulation, highlights regions of frequent pocket 

opening and regions where the Druggability Score of the pockets is higher than a set threshold 

over all the dynamics trajectory 

• New QM method in the 3D Pose tab, to perform Quantum Mechanics (QM) calculations on ligands, 

based on the PSI4 implementation: 

o Perform geometry optimization (minimization) and single-point energy calculations on ligands, 

ligand conformations and ligand poses: 

▪ HF, MP2 and DFT methods 

▪ Choice of functionals available for DFT 

▪ Choice of basis sets available  

▪ Single-point energy calculations can be performed in vacuum, water and choice of 

organic solvents (Linux only) 

▪ For each ligand, calculate the QM total energy of the minimized structure, the energy of 

the HOMO and LUMO orbitals and the dipole moment 

o Calculate and display the Molecular Electrostatic Potential (MEP) for individual ligands: 

▪ HF, MP2 and DFT methods 

▪ Choice of functionals available for DFT 

▪ Choice of basis sets available  

▪ Single-point energy calculations can be performed in vacuum, water and choice of 

organic solvents (Linux only) 

▪ MEPs are saved in the Surfaces window and can be displayed in the 3D window either 

as iso-surfaces or mapped to the solvent-accessible surface 

o Calculate QM torsion profiles for selected rotamers in ligands of interest 

▪ Wizard-driven to facilitate the correct set-up of the experiment 

▪ HF, MP2 and DFT methods 

▪ Choice of functionals available for DFT 

▪ Choice of basis sets available 

▪ Torsion profiles are saved locally for later reference  

• New Torsion Analysis function in the 3D Pose tab, to calculate torsion frequencies for ligands, 

conformations and poses based on the Torsion Library method 

o Color code each rotatable bond in the 3D window according to the corresponding torsion 

frequency value 

o Calculate torsion frequency counts to facilitate the identification of potentially problematic 

conformations and poses 

• New 2D Interaction Maps showing a 2D diagram of ligand-protein interactions for each selected 

ligand(s) with an associated protein 

o Show/hide different types of contacts  

o Optimize the orientation of the diagram by rotating, flipping and resizing the interaction map 

o Copy the interaction map into the clipboard 

o Interactively selects residues of interest in the 3D window by clicking on the corresponding 

residue the interaction map  

• New Column & Activity Editor to manage all data columns in the Ligands table: 

o Show/hide individual columns or group of columns in the Ligands table, Tiles view and 3D 

window 

o Move individual columns or group of columns in the desired position in the Ligands table 

o Add selected columns to the Filters and the Radial Plot 
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o Set columns as sources of activity data for QSAR, FEP and Activity Miner analysis, by setting the 

desired activity units and associated error (numeric activities) 

o Add, duplicate, remove and rename custom-created columns 

o Use a selected column as the source of the ligands Titles 

o Sort custom-created columns 

o Copy the content of selected column(s) into the clipboard in CSV format 

o Search the list of columns for those whose titles matches the search criteria 

o Set the column type choosing from Auto, Text, Number and SMILES 

• New MSI installers for Windows, to facilitate Flare installation in corporate environments 

• New ‘Copy residues to new chain’ option from the right-click menu of the Proteins and Alignment tables 

to copy the sequence of picked residues into the clipboard 

• New option to color molecules solvent accessible surfaces according to grid values 

• Enhanced Flare FEP calculations: 

o New feature to add link instances to selected transformation(s) in the perturbation network. 

For each individual instance: 

▪ Set lambda window schedule 

▪ Set custom simulation length 

▪ Include/exclude instance from relative activity calculation 

▪ Instances can be added and removed 

o New solvent model enabling to run the simulation in phospholipid membranes 

o New automatic creation of custom torsion parameters for small molecules using the ANI-2x 

deep learning QM approximation  

o New options to set the ionic strength, temperature and pressure for the simulation 

o New feature to set distance constraints to protein atoms to restrain protein movements 

o New feature to export FEP calculations from the GUI, to run them from the command line using 

pyflare 

o Import/export of FEP projects 

o Enhanced softcore parameters for improved predictive performance with complex 

transformations 

o Enhanced explicit solvent models 

o Enhanced management of activity values: 

▪ Set the activity precision in the Column & Activity Editor 

▪ Clear experimental activity of selected ligands 

o Improved handling of different tautomers/conformations of the same ligand in the perturbation 

network, enabling the exclusion of the undesired tautomer/conformation from the calculation 

of relative activity 

o Updated choice of pre-set calculation methods, now including different options to run 

calculations in explicit solvent/membrane with GAFF2/OpenFF 

o Transfer to Flare of the equilibrated complexes of multiple selected ligands 

o Enhanced ‘Select menu’ in the FEP ribbon now enabling the selection of all disconnected links 

in the FEP project 

• Enhanced molecular Dynamics: 

o New solvent model enabling to run the simulation in phospholipid membranes 

o New automatic creation of custom torsion parameters for small molecules using the ANI-2x 

method 

o New feature to set distance constraints to protein atoms to restrain protein movements 
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o New feature to export Dynamics calculations from the GUI, to run them from the command line 

using pyflare 

o New option to set the ionic strength for the simulation 

o Support to custom OpenMM XML files parametrizing non-standard residues and cofactors not 

supported by Flare 

o New and enhanced tools for the analysis of the dynamics trajectory: 

▪ 2D RMSD plot for monitoring protein structure changes over a dynamics trajectory 

▪ Root Mean Square Fluctuation (RMSF) analysis for each residue over a dynamics 

trajectory 

▪ Secondary structure analysis of dynamics trajectory 

▪ Contacts table now also shows a trajectory analysis of contacts 

▪ Contacts table now reports also hydrophobic interactions 

▪ Measurements in the 3D window can now be displayed also as histograms 

▪ Improved visualization of properties plot, now also showing the moving average 

▪ Ability to set/change anchor frame and atoms to align for calculating RMSD plots 

o Enhanced explicit solvent models 

o Improved handling of peptide ligands 

o Updated choice of pre-set calculation methods, now including different options to run 

simulations in explicit solvent/membrane with GAFF2/OpenFF 

o New option to load protein structures without adding hydrogens, to support loading a protein 

with a dynamics trajectory file generated by OpenMM 

o Improved handling of unit cell information and display of unit cells 

• Enhanced water analysis with GIST: 

o New surfaces significantly enhancing the interpretability of GIST results: 

▪ Water density, highlighting regions of high water density 

▪ Enthalpic happy/unhappy water, highlighting regions where the enthalpic contribution 

to water free energy is negative/positive 

▪ Entropic unhappy water, highlighting regions where the entropic contribution to water 

free energy is positive 

▪ Local happy/unhappy water, highlighting happy/unhappy regions of hydration and high 

water density 

o New automatic creation of custom torsion parameters for small molecules using the ANI-2x 

method 

o New option to resume incomplete GIST calculations by restarting the dynamics run 

o New option to set a custom output path to save the dynamics trajectories, enabling to restart 

the calculation 

o New option to set the ionic strength for the dynamics simulation 

o Updated choice of pre-set calculation methods, now including different options to run quick, 

normal and accurate GIST calculations 

o Improved, more informative log 

• Enhanced QSAR model building: 

o New and updated machine learning methods based on the scikit-learn library replacing the dlib 

methods available in previous versions of Flare. Note that Flare will no longer support the 

building of QSAR models based on the dlib library. 

▪ New regression and classification methods: Gaussian Process (regression), Random 

Forest (classification) 

▪ Updated regression and classification methods: Support Vector Machine (regression), 

Random Forest (classification) 



Flare release notes V9.0 

July 15, 2024 © Cresset  35 

o Improved display of Activity Atlas surfaces, with an option to show the surfaces only in the first 

cell in grid mode 

o Improved selection of custom descriptors in the QSAR model building advanced options, now 

enabling the selection/deselection of all columns in the Ligands table 

• Improvements to docking and scoring: 

o New ‘flickering waters’ feature to automatically toggle selected water molecules on/off during 

the docking run 

o New feature to export normal and covalent docking calculations from the GUI, to run them 

from the command line using pyflare 

o New option to save docking results into a pre-defined or custom-created role in the Ligands 

table 

o New option to customize the size of the docking grid when defined using a ligand  

o New advanced option to specify one or more frozen torsions in the ligands to dock, i.e., 

rotatable bonds which should be kept frozen in the input conformation during the docking run 

o Docking constraints on protein atoms are now saved when exporting the protein as a pdb file, 

and can be used when running docking experiments from the command-line using pyflare  

o Expanded range of electrophiles that are auto-recognized in covalent docking 

o Expanded list of covalent residues now including Threonine 

o Expanded range of metal binders matching metal binding docking constraints 

• Improvements to Conf Hunt & Align: 

o New option to save alignment results into a pre-defined or custom-created role in the Ligands 

table 

o New advanced option to keep only the most diverse alignments, filtering out alignments where 

the heavy-atom RMSD distance is less than a specified threshold 

o New feature to export conf hunt & alignment calculations from the GUI, to run them from the 

command line using pyflare 

• Improvements to Activity Miner: 

o New option to add cluster memberships to the Ligands table as a ‘Cluster ID’ column 

o New advanced options to control the field/shape proportion in the score similarity matrix, and 

to optimize pairwise alignments to maximize the similarity score instead of using the input 

orientation of ligands 

• Enhanced OpenMM protein minimization: 

o New automated creation of custom torsion parameters for small molecules using the ANI-2x 

deep learning QM approximation  

o Updated choice of pre-set calculation methods 

• Enhanced import of large protein files, now supporting also the PDBx/mmCIF file format 

• Enhanced open/save of project files from/to alternative file formats 

• Enhanced export of ligands, now including export of ligand structures in 2D 

• Enhanced 3D window graphics: 

o Enhanced 3D rendering of ligand/protein surfaces and protein ribbons 

o New background color gradient effects, with option to replicate the gradient effect when 

showing the 3D window in grid mode 

o Option to customize the light height, distance and angle 

• Enhanced ligand-protein contacts 

o New ‘hydrophobic’ interaction type 

o Monitor interactions with phospholipid membranes 

o Option show/hide labels in the 3D window 
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o Contacts shown as thin tubes, colors for each interaction type can be customized in the Flare 

Color preferences 

• Enhanced torsion energy plot in the Editing tools: 

o More precise estimate of torsion energy 

o Background of torsion energy plot color coded according to torsion frequencies calculated with 

the Torsion Library method 

o The torsion energy plot can be toggled on/off 

• Enhanced display of measurements (distance, angle and torsion) in the 3D window, now shown as thin 

tube, with colors customizable in the Flare Color preferences 

• Improved handling roles in the Ligands table, now saving the expanded/collapsed status of each role 

with the Flare project 

• Updated Python to version 3.9.9 

• Updated OpenMM to version 7.7.0 

• Updated OpenFF versions to include Sage V2.0 in addition to Parsley V 1.0.1, 1.1.1, 1.2.1, 1.3.1 

• Updated RDKit to version 2021.09.4 

• Updated Lead Finder to version 2112 build 1 

• Updated Build Model to version 2112 build 1 

• Re-designed Flare Preferences: 

o More intuitive and simplified grouping of preferences 

o New and enhanced General preferences: 

▪ New preference to control Flare’s file open/save behavior 

▪ New preference to set the directory where to save custom OpenFF torsion parameters 

created with ANI-2X  

▪ New preference to set the directory where to place custom OpenMM XML files 

▪ New preference to set the directory where to save QM torsion profiles 

o New 3D Display group of preferences, enabling to change the look and performance of the 3D 

window, including new preferences to set the default style for ligands, proteins and ribbons 

o New Colors group of preferences, to control/change the default choice of colors for the Flare 

project, including the following new/enhanced preferences: 

▪ Set colors of ligand-protein contacts in the 3D window 

▪ Set colors for measurements in the 3D window 

▪ Option to toggle on/off the background color of 2D structures in the Ligands table 

o New 2D display group of preferences, to customize the 2D display of ligands in Flare 

o Improved handling of local GPUs in the Processing preferences, now providing a list of all local 

GPU devices available with details about their configuration 

o New Connections group of preferences, to set Flare connections to the databases of electron 

density maps, network proxy, and Blaze 

o New Advanced group of preferences, including preferences for Conf Hunt & Align, Field QSAR 

and Activity Miner 

o Improved Tables group of preferences to set the default visibility status of columns in the 

Ligands table and Tile view for new projects, and in the FieldTemplater results table 

• New features and improvements for the Flare tab menus 

o Reorganized all tab menus to make them more intuitive and efficient 

o Home tab: 

▪ New ‘Constraints’ label, enabling to toggle on/off the display of constraints in the 3D 

window 
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▪ New options to color atoms by residue type and according to the secondary structure 

of the protein 

▪ New options to color protein ribbons by residue type and according to the secondary 

structure of the protein 

o New Cartoon ribbon style for proteins 

o New ‘Very thin sticks’ display style for ligands and proteins 

o New ‘Select’ option to select all ligands included in the currently selected Activity Miner project  

o Ligand tab: 

▪ New Columns button opening the Column & Activity Editor  

▪ New Ligand Prep dialog to prepare selected ligands, including options to re-charge the 

ligands at pH 7 using Cresset rules for protonation, stripping salts, and enumerate 

stereo-centers 

▪ New Clustering feature to cluster selected ligands based on different similarity metrics 

(including Field similarity for aligned ligands) and the specified similarity threshold 

▪ New Import Data feature to import CSV data and merge SDF data 

▪ Enhanced assignment of ligands to roles based on Murcko scaffold, now giving the 

option to either treat all heavy elements as equivalent, or keep element type into 

account 

o New 3D Pose tab, gathering functions for working in 3D with the ligands in the Ligands table 

o New Sequences tab, gathering functions to perform sequence alignment and protein 

superimposition, and to change the display of the Proteins and Alignment tables 

o Protein tab: improved Loop Modelling function, now giving the option to fix all gaps in the 

protein structure in a single run, saving only the best scoring structure for each gap 

o QSAR tab: 

▪ New Columns button to open the Column & Activity Editor, replacing the Activity 

Manager button 

▪ The Partition Data Set dialog now features a button to open the Column & Activity 

Editor, to set the primary activity column when using the activity stratified method 

▪ New export of machine learning QSAR models calculated using the scikit-learn library as 

an ONNX model 

▪ New feature to export Field QSAR model data and field samples for selected ligands 

o Activity Miner tab: new Columns button to open the Column & Activity Editor, replacing the 

Activity Manager button 

o View tab: 

▪ Enhanced Background Color feature, now enabling to set color gradients to the 3D 

window background 

▪ New Light Position button, to customize the lights in the 3D window 

▪ New Unit Cell button, to display the unit cell and symmetry-related proteins 

o Help tab: new Build 2D QSAR guided tour, showing how to build QSAR models using 2D 

descriptors and fingerprints 

• Improved Sequence Similarity table: clicking on protein titles selects the corresponding protein 

• Improved import of ligand and protein surfaces, now possible also using File→Open 

• Selecting a protein automatically scrolls the Proteins and Alignment tables to make the selected protein 

visible 

• Filtering the Ligands table for columns containing text now support using ‘*’ as a wildcard 

• Enhanced Surfaces window, now including an option to change surface transparency 
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• Improved sorting of ligands in the Ligands table, now synchronizing the order of display in the 3D 

window to that of the sorted column  

Changes in version 5.0 

• Ligand field calculations using the Cresset XED force field use a distance-dependent dielectric, for 

consistency with calculations performed on proteins 

• New Activity Miner module to enable the rapid navigation of complex SAR, using the concept of 

‘disparity’ or ‘activity cliffs’ to highlight regions in the SAR landscape where major changes have been 

observed 

o 3D field similarity of aligned ligands used a measure of distance 

o 2D similarity calculated with a choice of fingerprints can optionally be used as measure of 

distance 

o Multiple Activity Miner projects on multiple activity columns can be saved within same Flare 

project 

o Fully integrated within the Flare GUI 

• New Activity Miner tab grouping all functions for building Activity Miner models: 

o Create projects from selected ligands or all ligands in the Flare project 

o Activity Manager to select the columns containing activity data, and set up appropriate activity 

units and errors 

o Choose whether to use 3D field similarity of aligned ligands or optionally 2D similarity to 

calculate disparity 

o Change the color scheme for Disparity, Activity and Similarity 

• New Activity Miner windows to analyze and visualize relevant activity cliffs information: 

o Disparity Matrix: view the disparity information for all pairs of molecules in the Activity Miner 

project 

o Top pairs: view all molecule pairs that have a high disparity value for the specified activity 

o Activity View: examine the SAR around a particular compound 

o Cluster View: dendrogram showing the molecules in the Activity Miner project clustered using 

the currently selected similarity metric  

• New Qualitative and Quantitative Structure-Activity Relationships (SAR) model building module 

including the following methods: 

o Field QSAR using 3D descriptors, modeling the shape and electrostatic character of aligned 

molecules, to create a quantitative regression model. The interpretation of the model is aided 

by informative 3D visualization of electrostatic/steric coefficients and variance and contribution 

to predicted activity 

o Machine Learning for building quantitative regression and classification models 

▪ Choice of robust machine learning methods: Support Vector Machine, Relevance Vector 

Machine, Random Forests, k-Nearest Neighbor 

▪  ‘Automatic’ model building option to automatically run all the machine learning 

regression or classification models and save the model with the best statistics 

▪ Machine learning models can be built on Cresset 3D descriptors, modeling the shape 

and electrostatic character of aligned molecules, as well as 3D/2D imported descriptors 

and a choice of 2D fingerprints (kNN only) 

o Activity Atlas to generate qualitative 3D maps summarizing the SAR for the data series. Three 

different models are calculated:  

▪ Average of Actives: the average shape and electrostatic character of active molecules 
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▪ Activity Cliff Summary: summarizes the activity cliffs information from the Activity 

Miner disparity matrix 

▪ Regions Explored: the shape and electrostatic regions that have been explored so far. 

Calculates a Novelty score for each molecule 

• New QSAR tab grouping all functions for building QSAR models: 

o Activity Manager to select the columns containing activity data, and set up appropriate activity 

units and errors 

o Partition the data set into a training set (used to build the QSAR model) and a test set (used to 

validate the predictive ability of a quantitative SAR model) 

o Build the QSAR model by opening a panel which enables to choose robust default settings for all 

model types 

▪ Access to advanced options to fine-tune the model building process 

▪ Custom-defined model building settings can be saved within the Flare project as well as 

exported/imported 

▪ Multiple QSAR models on multiple activity columns can be saved within the same Flare 

project 

▪ Pre-defined role names in the Ligands table (Training Set, Test Set and Prediction Set) 

facilitate QSAR model building 

▪ QSAR models can be built from ligands in any role in the Ligands table 

o View informative 3D visualizations for Field QSAR and Activity Atlas models 

o Open QSAR Model window to visually compare different models 

o Calculate field kNN predictions which are not performed automatically as computationally 

expensive 

• New ‘QSAR Model’ dock window to analyze and visualize relevant QSAR model information, including 

the following tabs: 

o Activity: for regression models, shows the predicted vs. experimental activity plot for each role 

in the Ligands table; for classification models, shows the confusion matrices for each role in the 

Ligands table  

o Q2: plot of R2/Q2 vs. number of components/neighbors (Field QSAR and kNN) 

o RMSE: plot of Root Mean Square Error vs. number of components/neighbors (Field QSAR and 

kNN) 

o PCA: Principal Components Analysis plot to identify grouping of molecules and outliers in the 

descriptors space 

o 3D View: informative 3D visualizations for Field QSAR and Activity Atlas models 

o Notes: take model specific notes 

• New FieldTemplater module to build hypothesis of bioactive conformation, more detailed and 

informative than traditional pharmacophores. Enable the application of 3D techniques to target with no 

structural information 

• New GIST water analysis to assess the hydration of binding pockets and calculate the associated water 

thermodynamics by sampling explicit solvent distributions at the end of a molecular dynamics run 

• New Conformation Explorer to inspect and analyze conformation populations 

• New support for Electron Density maps, enabling download of maps at protein download and 

import/export of maps, and visualization of electron density information from the Surfaces window 

• New Protein Alternate Conformations window to review alternate conformations for protein and ligand 

atoms, enabling users to choose the preferred conformation before protein preparation in an 

interactive manner 

• Enhanced FEP calculations: 
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o Significantly faster algorithm (up to 3.5 x speedup over previous version) 

o Graph creation improvements 

▪ Automatic addition of intermediate structures to optimize success rates 

▪ When working in production mode, ligands which do not contribute to the perturbation 

network are excluded from the calculation and can be removed 

o Automatic determination of optimal lambda schedules, requiring minimal user interaction and 

providing additional speed improvement 

o System improvements:  

▪ LangevinMiddleIntegrator combined with Hydrogen Mass Repartitioning to get stable 

4fs timesteps 

▪ Solvent box shape now defaults to truncated octahedron, more efficient than 

orthogonal  

▪ Solvent box buffer now defaults to a smaller value of 6Å, making calculations faster 

without affecting quality of results 

▪ Longer pre-equilibrations, now running for 500 picoseconds by default 

▪ Choice of explicit water models  

o Support for larger datasets (up 500 molecules when using a star graph) 

o Clearer annotation of links affected by poor lambda overlaps 

o Option to manually set a custom lambda schedule for selected links 

o Improved 3D window visualizations within FEP projects 

o New commands in the FEP Project Home tab to clone and rename FEP projects, and hide links 

among ligands with known activity 

o Tooltip reporting number of GPU hours calculated/remaining 

o Option to force the re-equilibration of a ligand without clearing any completed links 

o Option to relax the requirement that ligands should be part of a cycle whenever possible, 

enabling the generation of ‘tree-like’ graphs 

o New check for duplicate ligands before starting a new calculation 

o FEP CPU calculations can now run locally 

• Enhanced molecular Dynamics: 

o Improved support for peptide ligands 

o System improvements:  

▪ Choice of explicit water models  

▪ New advanced options to set temperature, pressure, treatment of long-range 

electrostatics, non-bonded cut-off 

▪ LangevinMiddleIntegrator combined with Hydrogen Mass Repartitioning to get stable 

4fs timesteps 

▪ Solvent box shape now defaults to truncated octahedron, more efficient than 

orthogonal  

o Improved Contacts table to monitor favorable ligand-protein interactions: 

▪ Interactive: clicking on a ligand/protein atom label in the Contacts table highlights the 

atom in the 3D window, double-clicking focuses the 3D view on that atom 

▪ Table creation significantly faster 

▪ The table is now saved within the Flare project and can be exported 

o Images of the Dynamics plots can now be copied in the clipboard and saved in different file 

formats 

o Added support for post-translationally modified amino acids with AMBER 

• Enhanced minimization of ligands, proteins and protein-ligand complexes now also supporting 

OpenMM minimization using the AMBER GAFF/GAFF2 and Open force fields 



Flare release notes V9.0 

July 15, 2024 © Cresset  41 

• Improved ligand-based alignment: 

o Improved Conformation Hunt and Align panel 

o Enhanced advanced options for alignment, now including: 

▪ Option to bias substructure alignment towards a specific substructure specified by a 

SMARTS pattern 

▪ Option to set relative weights to each reference used in alignment 

▪ Option to set relative weights to each field used in alignment 

▪ Additional ligand similarity metrics: Tanimoto and Tversky 

• Enhanced virtual screening of thousands of compounds, now including also scoring by QSAR model 

predictions 

• Improved protein preparation panel now enabling to: 

o Choose/create a role for extracted ligands 

o Remove water molecules outside of the active site 

• Improvements to docking and scoring: 

o New docking constraints definitions to map pi-stacking, cation-pi and salt-bridge interactions 

o Expanded range of electrophiles that are auto-recognized in covalent docking 

• Improved editing of ligands: 

o New ‘Optimize Alignment’ button in the Editing Tools menu to gently optimize the alignment of 

the ligands being edited to up to 9 selected ligands, optionally using a selected protein as an 

excluded volume 

o New ‘Clear Column Data’ button in the Editing Tools menu to clear all data associated with the 

ligand being edited 

• Improved open molecules panel now enabling to choose/create a role and add a role description for the 

ligands being imported 

• Improved export of ligands: 

o Multiple ligands with multiple conformations can now be exported to a single sdf file 

o Export of alignments/poses is now available also for selected molecules 

• Significantly improved import and export of CSV files, now enabling to add/merge data into the Flare 

project, and to export CSV data for selected ligands only 

• Improved access to Cresset Flare Python extensions and scripts, now distributed within the main 

package and available for all users without a separate download 

• Improved Protein Structure Checker now also reporting gaps in protein structure 

• Updated Python to version 3.6.13 

• Updated OpenMM to version 7.5.0 

• Updated OpenFF versions to include Parsley V 1.0.1, 1.1.1, 1.2.1, 1.3.0 

• Updated RDKit to version 2020.09.4 

• Updated Lead Finder to version 2104 build 1 

• Updated Build Model to version 2104 build 1 

• New features and improvements to the Ligands table: 

o Roles: 

▪ New button near role name to select all ligands in a role 

▪ Double-click on a role name to rename the role 

▪ Roles can be moved up and down from the role right-click menu 

▪ Duplicate roles from the role right-click menu 

o Columns 

▪ The background of columns in the Ligands table is now color-coded according to the 

radial plot property profile for that column 
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▪ The Ligands table can now by filtered also by index 

▪ Custom columns can be used to set ligands title 

• New and improved Flare Preferences: 

o New Appearance preferences options to: 

▪ Set the color of steric/electrostatic variance and favorable/unfavorable electrostatic 

contributions for Field QSAR 

▪ Set the color of the conformation energy gradient and conformation torsion frequency 

gradient for the Conformation Explorer 

▪ Hide smaller field points 

▪ Disable the energy plot when rotating a molecule bond during editing 

o Improved display of ligand field points by setting the default field scaling from radius to area in 

the Flare Appearance preferences 

o New Calculations preferences option enabling users to set the directory where to save the 

results when creating custom GAFF/GAFF2 torsion parameters 

o New General preferences option to set the download URLs for electron density maps 

o New Table preferences option to color the columns in the Ligands table according to their fit to 

the radial plot property profile, and set the color scheme 

• New features and improvements for the Flare tab menus 

o Reorganized all tab menus to make them more intuitive and efficient 

o Home tab: 

▪ New ‘Focus’ button to focus the 3D View on the selected ligand/picked atoms 

▪ New ‘Search Molecules’ interface enabling rapid identification of ligands, proteins, 

proteins residues and protein sequences through text, SMILES and SMARTS search 

▪ New ‘Ligand Filters’ button to rapidly open the Filters window 

▪ New ‘Select’ menu to rapidly select the desired subsets of ligands and proteins 

▪ ‘Capture Scene’ button was moved from the View to the Home tab to facilitate use 

▪ Improved coloring of proteins and ribbons by temperature factor, now coloring also the 

ligands associated with the protein and showing the temperature factor range to 

facilitate set up 

▪ Improved ‘Contacts’ panel now also showing ligand interactions with metals 

o Ligands tab 

▪ Ligands can now be created from SMILES 

▪ New ‘Plot’ button to create interactive plots for the columns in the Ligands table 

▪ New ‘Histogram button to create interactive histograms for the columns in the Ligands 

table 

▪ New ‘Copy to All Ligands’ button to copy the current ligand surface settings to all 

ligands 

▪ New ‘Set Role’ button in the Ligand tab to assign ligands to a chosen role 

▪ New function to assign ligands to roles based on their Murcko scaffold 

▪ New function to align the 2D image of all ligands in the Ligands table to the image of 

the selected ligand 

o Protein tab: Loop Modelling, Ramachandran and Contact Map extensions are now installed by 

default and accessible from the ‘Structure’ group 

o View tab: new ‘Depth of Field’ button giving control over camera’s aperture, enabling blurring 

of background objects 

o Help tab: new ‘Tours’ that guide users through available and customizable experiments 

• Protein surfaces: 
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o Improved ‘Surfaces’ window now enabling import/export of electron density maps, and 

different types of actions on protein surfaces (show/hide, duplicate, export, delete, select 

associated protein) 

o Protein surfaces saved in the ‘Surfaces’ window can now be renamed 

o Option to color a protein surface according to residue 

o Improved generation of protein surfaces now including only atoms lining the active site 

• New option to hide/unhide proteins in the Proteins table 

Changes in version 4.0.2 

• Performance improvements to run ligand-based alignment, ligand minimization and docking 

experiments from the Flare GUI at a 10K scale 

• Fixed bug which prevented FEP calculations to work on GPUs set to PROCESS_EXCLUSIVE mode. 

Changes in version 4.0.1 

• Fixed bug in the calculation of predicted G values when running FEP in benchmarking mode, which 

may have led to an overestimate of the statistical performance (in terms of R2 and MUE) for the project 

• Fixed bug which caused Flare to detect the CUDA drivers incorrectly on multi-GPU machines. 

Changes in version 4.0 

• New and improved force fields: 

o New Open Force Field (Parsley 1.1.1 or 1.0.1) for FEP, Dynamics and WaterSwap calculations, 

with a flexible implementation enabling users to easily update to the latest version 

o New Custom Force Field wizard to create AMBER GAFF or AMBER GAFF2 custom parameters for 

ligands of interest, based on Quantum Mechanics calculations 

o New Parameter Explorer, showing a report for the available custom parameters for GAFF and 

GAFF2 

• New and improved features for FEP calculations: 

o Faster algorithm, with up to 20% improvement in performance 

o New ‘Star-graph’ networks, optimized to explore how changes to the selected molecule in the 

center of the graph affect activity 

o New ‘Production’ mode, which adjusts the perturbation network to prefer direct links to 

molecules with known activity, and uses available experimental activity data in the final 

computation of ligand ΔG values, enabling more precise calculations 

o New quick-mode, to run the FEP simulation using only single-way calculations, considerably 

speeding up the calculations 

o New Atom Mapping viewer, to inspect and modify the current atom mapping for two ligands 

connected by a link 

o New FEP resources calculator, providing a detailed report on the total number of ligands, links, 

perturbations and lambda windows in the project, as well as an estimate of the number of GPU 

hours required to run the experiment 

o New, optimized algorithm for calculating predicted activities and associated errors 

o New option to specify a directory for storing the intermediate results of the FEP calculation 

o New option to transfer equilibrated protein-ligand complexes back to the main Flare project 

o New visualization of protein solvent-excluded surfaces  

o Improved algorithm for inclusion/exclusion of links in the analysis of results 
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o Improved mapping of H atoms, now taking into account 3D coordinates 

o Improved FEP project creation GUI, now enabling to import activity values in different units, 

automatically transforming them into G values 

o Improved logging of FEP calculation results 

o Improved definition of water boxes, now generating smaller, more effective water boxes 

o Highlighting of unmapped atoms when links are selected 

• New and improved features for Dynamics, including: 

o New Analysis button, opening the Dynamics analysis widget to view: 

▪ RMSD plot 

▪ Plots of physical properties: potential energy and temperature of the system, box 

volume and density. These plots can be exported as a .csv file 

▪ Contacts table, reporting contact statistics for favorable ligand-protein interactions 

observed during the simulation 

▪ Measurement plots, which can be created for each measurement (distance, angle or 

torsion) shown in the 3D window. These plots can be exported as a .csv file 

o New capability to resume a completed dynamics experiment, adding more calculation time to 

the simulation 

o Improved, interactive RMSD plots, also showing additional information such as protein name 

and number of visible atoms 

o Improved handling of storing/retrieving dynamics trajectories 

• New Structure Check function, to check the selected protein structure for potential problems which 

could not be resolved during protein preparation 

• New and improved protein preparation advanced options: 

o Option to keep the ligand unchanged during protein preparation (off by default) 

o Option to fix 1- and 2- residues gaps (on by default). Larger gaps can be fixed using the FREAD 

Python extension 

o ATP/ADP are now correctly recognized as cofactors 

• Updated Python to version 3.6.9 

• Updated OpenMM to version 7.4.1 

• Updated RDKit to version 2019.09.3 

• Updated Lead Finder and Build Model algorithms  

• Improved ligand minimization, now enabling the minimization of multiple ligands at the same time and 

now reporting the RMSD of the minimized ligand position compared to its pre-minimized starting co-

ordinates 

• Improved handling of docking constraints, now enabling to set a maximum tolerated constraint penalty 

which must not be exceeded for the pose to be retained 

• GUI new features: 

o Option to color ligand and protein atoms by XED partial charge 

o Protein surfaces can now be shown as wireframe (mesh) 

o New ‘Conf Energy’ column in the Ligands table capturing the relative conformation energy for 

each generated conformer relative to the lowest energy conformation 

o Option to export of ligands together with their associated protein 

o Keyboard shortcut ‘V’ for setting favorites 

o New Color Sequences button to change the background color of residues in the Proteins and 

Alignment tables to match the color shown in the 3D window, or the secondary structure of the 

protein 

o New option to manually cap terminal residues or residues near a gap from the right-click menu 
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o Labelling of atoms according to AMBER type 

• GUI improvements: 

o Improved display of relevant protein information in the protein Title tooltip, now reporting the 

resolution for the imported protein, the total number of residues and heavy atoms 

o Improved display of salt-bridge interactions 

o Improved ‘Send to Blaze’ functionality, now providing information about how to connect Blaze 

to Flare 

o Improved handling of error messages now giving hostname information to help debugging on 

large clusters 

o Improved export of high-resolution pictures of the 3D window with either opaque or 

transparent background 

• Bug fixes: 

o Fixed bug which occasionally generated unrealistic poses when covalently docking ligands 

containing a cis amide 

o Fixed bug which occasionally made covalent docking fail to generate the correct stereoisomer 

for the docked ligands 

o Fixed bug which occasionally caused the Home tab to disappear 

o Other bug fixes 

Changes in version 3.0 

• New Free Energy Perturbation (‘FEP’) module in the Ligand tab, to predict relative binding affinity 

changes within a congeneric ligand series.  

• New ‘Covalent Docking’ module in the Ligand tab, for predicting the binding pose and interactions of 

covalent inhibitors 

• New template docking option available for standard and ensemble docking experiments, useful in those 

cases where the pose of a ‘template’ ligand is known and can be used to bias the docking results for 

congeneric compounds 

• New ‘Dynamics’ module in the Protein tab, using OpenMM to study the conformational changes of 

proteins and the stability of ligand-protein complexes 

• New ‘Conf Hunt and Align’ module in the Ligand tab, to perform ligand-based alignment 

• GAFF2 force field now available for 3D-RISM, WaterSwap, Dynamics and FEP 

• New Tiles view showing a compacted version of the Ligands table 

• New Sequence Similarity table reporting the results of sequence alignment in a matrix format 

• New and improved editing of ligands, proteins and waters in the 3D window, including all the Molecular 

Editor functionality of previous Flare releases, enabling at the same time full access to ligand and 

protein selection and appearance changes functionality. Also including:  

o Full access to all the periodic table elements 

o New button to edit protein residue information 

o New button to fix and reorder protein residues based on current connectivity  

o New option to edit a selected portion of a molecule 

o Relative manual movements of proteins now possible 

• New functions and options for the Home tab: 

o Ribbon colors menu, to color protein ribbons independently from the color of carbon atoms, 

and to color ribbons by residue, protein sequence, protein chain and protein temperature 

factor 

o Option in the ‘Ribbon’ button to set ribbon transparency 
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o Ribbons can now be displayed also for DNA and RNA 

o Atom colors option to color also non-carbon atoms with a solid color 

o Option in the Atom Pick panel to pick atoms by name 

o Option in the Atom Pick panel to find specific residue sequences 

• New functions and options for the Ligand tab: 

o ‘New’ button to create new ligands from scratch 

o ‘Constraints’ button for adding or removing docking constraints to picked protein atoms, or to 

set ligand constraints for alignment and virtual screening 

o ‘Send to Blaze’ button to run new Blaze searches from Flare 

o ‘Download Blaze Search Results’ button to retrieve the results of existing Blaze searches 

o ‘Remove all Tags’ option to remove all tags from selected molecules 

o  ‘Diff’ button to show field differences for two selected ligands 

• New customizable option in the standard, ensemble, template and covalent docking calculation panels 

to set the number of independent docking runs for each ligand, keeping the best poses overall 

• New ‘Show Secondary’ button in the Proteins tab to show a colored line above the residue names in the 

Proteins and Alignment tables, corresponding to the secondary structure 

• New functions and options for the View tab: 

o ‘Synchronize Selections’ button to keep in sync the selection of ligands and associated proteins 

o Option to choose the screen to use for Full Screen mode 

o Option to set the stereo method for the current project 

• New Help tab to access Flare documentation and information, giving access to: 

o Flare manual and Flare Python Developers Guide 

o  ‘Tips and Tricks’ page on the Cresset website 

o Information about the Flare version and relevant licensing information, including the Flare 

license expiry date 

o Cresset website 

o Flare release notes 

o Online form to register to the Cresset newsletter 

o email to Cresset support 

o Generation of diagnostic data 

• New filter button in the Alignment table to show only protein chains belonging to the desired alignment 

group 

• New right-click options in the Proteins and Alignment tables, including: 

o Choose a specific protein chain to set the residue sequence numbering in the ruler 

o Select a protein’s associated ligands 

o Invert the current selection of proteins 

• New right-click options for the Ligands table, including: 

o Set ligand constraints for alignment and virtual screening 

o Select a ligand’s associated protein 

o Clear the protein association 

o Invert the current selection of ligands 

o Export selected docked poses and alignments 

o Convert conformation to poses 

o Choose any user column as the molecule title 

o Choose the column to use as a label in the 3D window 

o Set user column type (text/number) 
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• New advanced options to disable small side chain movements and to remove atoms from residues with 

incomplete backbone during protein preparation 

• New right-click options for the 3D window: 

o Add custom labels/annotations to ligand and protein atoms 

o Select ligands and proteins 

o Add or remove docking constraints to picked protein atoms 

• New import and export of Flare Preferences from the command line 

• New Appearance Preferences options: 

o Customizable option to limit the maximum number of ligands to display, giving a warning when 

the maximum number of ligands is exceeded 

o Option to disable pink halo highlighting atoms under the mouse cursor 

o Option to change the default green=good and red=bad colors for good/poor electrostatic 

complementarity, favorable/unfavorable 3D-RISM waters, favorable/unfavorable interaction 

free energies for WaterSwap into a custom color 

o Maximum copy picture size resolution can now be set to 10x 

• New Calculations Preferences panel, to set the maximum number of alignments to generate for each 

ligand 

• New Table Preferences panel, to customize visible/hidden columns in the Ligand table and 

visible/hidden tile items in the Tiles view 

• New option to use all available local CPUs, relaxing the 16-CPUs limitation in previous Flare releases 

• New Blaze Preferences panel, to set-up the communication with Blaze 

• Improved and faster XED minimization algorithm 

• Improved handling of metals in the XED force field – most common metals (Zn, Fe, Mg, Ca etc.) found in 

a protein environment should be modelled more accurately 

• Improved atom typing during protein preparation 

• Improved handling of DNA and RNA 

• Improved handling of larger datasets 

• Improved Electrostatic Complementarity algorithm, including: 

o Restricting the EC calculation to regions of the ligand surface which are in contact with the 

protein 

o Calculation of Electrostatic Complementarity scores for ligand alignments 

o Electrostatic Complementarity scores are now calculated against each associated protein for 

ensemble docking poses 

• Improved ‘Accurate but Slow’ and ‘Very Accurate but Slow’ docking calculation methods for standard, 

ensemble, template and covalent docking, now performing 3 independent docking runs and keeping 

the best poses overall 

• Improved ‘Score Only’ calculation method mode for standard, ensemble, template and covalent 

docking, now giving the option to disable pose optimization 

• Improved handling of conjugated bonds in Lead Finder 

• Improved docking processing panel, now including by default the ion and cofactors chains in the 

docking experiment 

• Updated AmberTools version to AmberTools 2019 

• Updated Lead Finder and Build Model algorithms  

• Updated Sire to version 2019.1.0  

• Updated RDKit to version 2019.03.4 

• Improved Contacts panel, including: 
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o New contact definitions for weak H-bonds and salt-bridge interactions 

o Full control on the interactions to show, with fully customizable matrixes for favorable and 

favorable interactions 

o New option for keeping the matrixes for favorable and unfavorable interactions in sync 

o New option to show the interactions in bold style 

o New option to show only interactions between associated molecules 

• Improved Filters window, now including: 

o A new green/red toggle to control whether each filter is enabled or disabled 

o A new settings button enabling import and export of the set filters 

• Improved filtering options for text columns, now including ‘equal’, ‘not equal’, ‘containing’ and ‘not 

containing’ options 

• Improved structural filters now including pre-defined filters for Ring, Aromatic Ring, Non-ring atom, 

Chiral atom, H-bond donor and H-bond acceptor 

• Improved Processing Preferences panel, including a completely redesigned GUI for setting and 

customizing multiple Cresset Engine Brokers, and a section to set local GPU processing 

• Improved PDB download widget now supporting multiple PDB download paths 

• Improved Radial Plots and Multi-Parameter Scoring, including: 

o New settings button in the Radial Plots Properties window, enabling import and export of the 

radial plot properties profile, and to restore the radial plot properties to default values 

o New option to specify whether invalid values for each property should be shown at the edge or 

at the center of the radial plot 

• Improved 2D display of molecules 

• Improved ‘Move to Protein’ button in the Ligand tab, now allowing to move a selected ligand to a new 

protein in the Proteins table 

• Proteins can now be sorted and reverse-sorted by protein title in the Proteins and Alignment tables 

• Improved way for drawing of sequence alignment constraints 

• Calculation and display of protein surfaces is now performed by default on visible atoms 

• Improved export of molecules with drag-and-drop, now exporting all Ligands table data as sdf tags. 

• Improved ‘Atoms’ button to show/hide atoms and bonds, now giving the option to show only picked 

atoms 

• Improved ‘Color by residue’ function, now coloring atoms and ribbons by residue type 

• Smoother transition across Storyboard scenes 

• Improved layout of all Flare ribbon menus 

Changes in version 2.0.1 

• Windows only release, to fix an issue causing an incorrect update of the 3D window. This issue only 

affects systems with an Intel GPU and drivers version 24.* or later on the Windows operating system. 

Changes in version 2.0 

• New Flare Python API enabling Flare functionality to be accessed from Python and customization of the 

Flare interface. Python scripts can be run from the Flare graphical user interface (GUI) or by the 

command line pyflare 

• New Python tab in the Flare GUI providing access to the Flare Python API functions within the Flare GUI 
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• New Electrostatic Complementarity Scores, calculated for each ligand based on the associated protein 

and saved as columns in the Ligands table. These provide three alternative quantitative scores of how 

well the electrostatics of one or more ligand(s) matches that of the associated protein active site 

• New electrostatic complementarity surfaces for ligand and proteins, providing a detailed visual map of 

ligand/protein electrostatic complementarity 

• New electrostatic potential surfaces for ligands and proteins, colored according to the electrostatic 

potential calculated with the XED force field 

• New coloring of protein surfaces by secondary structure and Wimley-White residue hydrophobicity 

• New Ensemble Docking functionality, for considering active site flexibility when alternative active site 

conformations of the same protein are available 

• New Filter window, to show in the Ligands table only the ligands that conform to a desired set of rules. 

Includes filtering on numerical values, text data, Boolean values, tags, ligand structure using either a 

SMARTS string or a substructure sketched into the Flare Molecule Editor 

• New Storyboard window, to capture scenes recording all details from the 3D window that can easily be 

recalled when needed, including the capability to annotate and rename scenes 

• New Radial Plot in the Ligands table to support Multi-Parameter Scoring 

• New 3D-RISM Surfaces button, to recalculate and display 3D-RISM surfaces when a completed 3D-RISM 

analysis is available for the selected proteins 

• New ‘Promote Pose to Ligand’ menu button to promote a chosen docked pose to ligand status 

• New ‘Delete Docking Grid on Selected Proteins’ function to delete unused docking energy grids, 

reducing the amount of disk space in the saved Flare project 

• New spherical clipping of protein surfaces 

• New border text displaying relevant information at the edge of the 3D window, especially useful when 

working in grid mode 

• New ‘Export all proteins’ functionality 

• New export file format for proteins as PDB files with Amber conventions 

• New export of ligand field surfaces 

• New ‘Move to protein’ menu button to merge a ligand to a chosen protein structure 

• New button in Flare Appearance Preferences to swap color of Cresset fields (blue/red) 

• Updated Lead Finder and Build Model algorithms  

• Updated sire (which contains WaterSwap) to version 2018.1.0  

• Updated AmberTools to version 18 

• Updated RDKit to version 2018.03.1 

• Improved protein superimposition now allowing the superimposition of all proteins vs. selected 

proteins 

• Improved coloring of crystallographic water molecules according to calculated 3D-RISM G 

• Improved WaterSwap workflow 

• Improved weighting scheme for consensus calculated free energy of binding from WaterSwap runs 

• Improved functionality of Protein Surfaces window, now enabling the update of saved protein field and 

molecular surfaces in terms of transparency, quality and chains included  

• Improved definitions for ligand-protein interactions, as fully documented in the Flare manual 

• Improved import of peptides as ligands 

• The FieldEngine binary now enables the setting of the maximum number of cores the process should 

use 

• Improved performance of multi-threaded docking runs 

• Improved layout of the functions in the Protein tab 
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• Improved display of protein entries in the Proteins table: the protein name is now the PDB code/file 

name for the protein; name column is resizable; background color for the ‘visibility’ icon matches the 

color of protein carbon atoms 

• Improved right-click menus 

• Improved ‘mark as favorite’ behavior for ligands 

• Improved functionality for moving all/chosen ligand(s) from protein(s) into the Ligands table 

• Improved logging for most functions 

• Improved ligand minimization, protein preparation dialogs 

• Improved clipping of front and back Z-planes in the 3D window, now allowing to choose whether the 

ligands should be affected by the clip planes 

• Improved Flare shortcuts 

• Lots of additional improvements and bug fixes. 

Version 1.0 

• Initial release of Flare. 

File Format Compatibility 

Flare project files saved with a minor version of Flare can be read by any version of Flare with the same 

minor version number. For example, a Flare project file saved with Flare 8.0.1 can be opened with 8.0, 

likewise a Flare project file saved with Flare 8.0 can be read with 8.0.1. 

Newer versions of Flare can open any project file saved with an older version of Flare. For example, Flare 9 

can open Flare 2.0 project files. 

Flare can save project files as an older format by selecting ‘File’ → ‘Save Project As’ and setting the ‘Save as 

Type’ to the previous version. For example, Flare 9 can save Flare 8.0, 7.2/7.1, 7.0 project files. 

Flare can also read the following data from Spark 10.7/10.7.1:  

• Search molecule 

• Reference molecule 

• Result molecules 

• The protein 

 

However, the following data will not be imported: 

• Field points on the molecules 

• Constraints 

 

The reason for this is that Flare, unlike Spark 10.7/10.7.1, uses a distance-dependent dielectric (DDD) in 

field calculations: mixing Flare field points with field points from Spark is scientifically invalid. For the same 

reason, Spark alignments should be rescored to recalculate the similarity values using DDD fields.  

Note that Flare 9 creates databases with a different database format from stand-alone Spark. Flare can read 

and use Spark-format databases, but not the other way round. 

Reading data from Forge/Torch projects is no longer supported from Flare 8.0. 
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Uninstalling Flare 

Windows 

Flare can be uninstalled using the standard ‘Apps & features’ tool.  

• In the search box on the taskbar, type ‘Add or remove programs’ and select it from the results. 

• In the ‘Apps & features’ window, find ‘Cresset Flare’. 

• Click on the on the ‘Cresset Flare’ icon and select Uninstall, then follow the directions on the screen. 

Linux 

If Flare was installed from a rpm package, it can be uninstalled with one of the following command lines, 

depending on whether it was installed with the rpm or yum command: 

rpm -e cresset-flare-<vers>-1.<arch> 

or 

yum erase cresset-flare-<vers>-1.<arch> 

If Flare was installed by unpacking a tar.xz file, it will be sufficient to remove the Flare folder from the 

disk. 

macOS 

In the Finder sidebar, click ‘Applications’. Drag the Flare icon from the Applications folder to the Trash 

(located at the end of the Dock). 

Known Issues and Bugs 

• It is no longer possible to download in Flare electron density maps with 1/3 to 1/2 resolution, due to 

changes to the RCSB download services  

• On some occasions, the analysis of a molecular dynamics trajectory cannot be performed on Linux or 

macOS if the trajectory .dcd file is stored at a location which contains the <space> character in the file 

path 

• Flare cannot read license files stored at locations which contain the ‘@’ character in the file name 

and/or the file path 

• Flare will give a segmentation fault and not start on the Debian operating system with the NVIDIA 

340.xyz driver 

• Some 3D graphics effects such as showing the window to full screen and Depth of Fields may not work 

correctly on MacBook Air M1 

• On some occasions, Flare may experience a critical error when running ligand-based alignment 

experiments on ligands containing metals  

• In some rare occasions, FEP in Flare may fail to generate a correct atom mapping for pseudosymmetric 

ring substituents. It is recommended to visually check, and if appropriate manually correct, the atom 

mapping using the Atom Mapping function on the FEP project tab menu 

• Flare may not operate optimally on remote systems like Citrix Virtual Apps. For optimal user experience, 

it is recommended to run Flare locally 
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• Optimal performance for GPU calculations in Flare is achieved with NVIDIA CUDA: please install the 

latest NVIDIA GPU drivers to use CUDA. OpenCL is generally slightly less performant (~2-5%) but is 

available for non-NVIDIA GPUs 

• On some occasions, Flare may experience a critical error on laptops with a Wacom pressure-sensitive 

pen and touch screen. Disabling the Wacom pen driver solves the issue. 

• Flare will crash when the File dialog is opened if ‘Dell Backup and Recovery Application’ between 

versions 1.7.5.64 and 1.9.2.8 (list not inclusive) is used on your computer 

• The 3D window may not work smoothly in the Windows, Linux and macOS environment when using 

very large desktops. The workaround for this issue is to set the environment variable 
QT_AUTO_SCREEN_SCALE_FACTOR=0 

• The active stereo (Quad Buffer) on Windows 10 may not work on older graphic cards, due to limitations 

of the NVIDIA graphic driver. 

 

Found a bug or problem that is not listed? Please contact us and help improve our software! 

Third party software 

A range of open source and free software libraries and executables are incorporated in each Flare 

installation. License agreement information for each third-party software can be found in the 

'documentation' subdirectory of the Flare installation directory and at https://www.cresset-

group.com/products/third-party-licenses/. Contact us at support@cresset-group.com if you wish to obtain 

the source code for any open-source component. 

Support 

Cresset  
New Cambridge House 
Bassingbourn Road 
Litlington 
Cambridgeshire, SG8 0SS, UK 

+44 (0)1223 858890 
support@cresset-group.com 
www.cresset-group.com/ 
Twitter: @cressetgroup 
LinkedIn: Cresset group 
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